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CHAPTER ONE 

Ks, MEGs, 
AND DISKS 

People who've been working with the Mac for a while · Technical Magic 
start tossing around jargon like, "It won ' t fit cuz it's a 
900K document, " or "My SE has 30 megs," and people 
who are not familiar with the Mac feel dumb because it 
all sounds so esoteric and we're sure we' ll never be able 
to understand all this sophisticated computer stuff a!ld 
besides we don't want to know all that technical stuff 
anyway we just want to learn how to run the darn thing. 
Well, as far as technical stuff goes, all most of us need to 
know is the machine is magic. Pure, simple, magic. Like 
an airplane. 

Knowing the difference between a bit and a byte and a 
Kanda meg, though, can help organize things in your 
brain a little bit so what you are working with will make 
more sense. This is how it goes: 

Actually, the computer isn 't that smart; it can only count Bits 
to one. Remember in school when we learned the binary 
system, wh ich we have now completely forgotten about, 0 1 
except that for some reason you could only count from Each one of these is one bit 
zero to one and you had to use exponential notation? 
Well, Mac uses a binary system: it counts zero and one-
zero means Off and one means On. See, it sends these 
little electronic messages, each a series of Off and On. 
And each one of those li ttle messages is a bit. 

Now, one little bit doesn't tell the computer a whole 
lot, so it strings together a bunch of bits to create a 
more important message: eight bits, such as 01000001, 
makes one byte. As you can see in the column to the 
right, one byte of information is still rather limited-
it takes a lot of bytes to create any sort of document. 

So a bunch of bytes is grouped together and called a 
kilobyte. You would think that a ki lobyte would be a 
thousand bytes, yes? No. Since the computer ca on ly 
count to one, the closest it can get to 1000 in its binary 
system with exponential notation is 1024. But wegener­
ally round it off and say the re 's about 1000 byteJ in a 
kilobyte. And kilobytes are the Ks everyone talks about. 

Bytes 

01000001 
This ll)•le represents 
the letter A 

Kilobytes 
A pproximalely 
1000 Bytes 
equals 1 Kilobyte 

5 



Ks, MEGs, AND DisKs 

6 

Floppy Disks 

[[]] 

How do Ks figure in real life? Kilobytes are what disk 
: space and file/document size are measured in; the larger 
. and more sophisticated the document or the software 
· program, the greater the number of Kit will occupy on 
· the disk. 

. You've probably seen the nice little 3.5" floppy disks tha t 
· the Mac uses. A disk stores the information for running 
· the computer, for operating the programs, for saving the 
: documen ts you create . Originally the Mac could only deal 
. with a single-sided disk (one that took infom1ation on 
. only one side of itself), but unless you have a very old 
· machine w:itl1 only a single-sided drive, you won ' t be using 
: single-sided disks. 

Disk Capacity · A double-sided disk can hold about BOOK (kilobytes) 
· worth of data. Four pages of double-spaced typewritten 
: text takes about 6K; therefore, you can get about 500 pages 
. of textual information on one disk (leaving some room 
. for the messages it has to send to the computer). Spread­
. sheets, graphics, and other complex info take up a lot 
· more space, of course. 

Caring for · Why is it called a floppy disk when it's not floppy? 
Floppy Disks · Actually, it is floppy. If you slide over that metal end you' ll 

· see the floppy disk inside. Don 't touch it! It's full of tiny 
: messages that your oily fingers or sharp nails can destroy . 
. Keep your disks away from heat: they' ll warp just like a 
· record album when left in your ho t car. And keep them 
· away from magnets- a magnet will destroy all the data on 
· the disk. So don ' t attach them to your refrigerator; don ' t 
: store them near your telephone or ste reo or any other 
. electronic device; and don't pile them on top ofyour 
· magnetic paperclip ho lder . 

. It is also recommended you don ' t keep disks in those 
· little p lastic bags they often come in ; the plastic can build 
. up static e lectricity which has the potential to destroy m e 
: precious data. 

Initializing a · When you buy your fl oppy disks, they aren ' t formatted 
New Disk · and so must be initialized. They come that way because 

: other types of computers are now using m ese handy little 
. things, and they can be ini tia lized for either type. So when 
. you first insert an uninitialized disk, Mac asks you several 
· questions. You need to name the disk and you need to 
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choo" to initiah" it ' ingl"'ided o' doubl"'idJ 
Obviously, if it's a double-sided disk you' ll choose 
double-sided. The system may warn you tha t you are 
going to erase all the information on the d isk, but since 
it's blank, so what. When you finally click OK, Mac wi ll 
lay down the formatting it needs to store all the valuable 
info you will be giving it. 

It is possible to lock a disk. When a disk is locked, who- Locking a Disk 
ever is using it cannot change anything on it. Neith er · OJ 
can it be printed from, nor can other fi les be saved on to · 
it. To lock a disk, find the li ttle black tab in the corner. . 
You'll notice you can slide it up or down. : • 

• When the tab covers the hole, the disk is unlocked. This disk is unlocked 

• When you can see through the hole, the disk is 
locked. 

A hard disk is actually a large, hard disk, rather than a 
floppy piece of fi lm. In principle it works the same as a 
floppy disk, but it can hold a great deal more data. The 
hard disk itself can be installed inside your Mac, or it 
may be a separate unit. Either way, a hard disk is a 
storage container for holding all your documents and 
software applications, and typically holds your System 
Folder for starting your machine (see pages 9-11 for 
more info on the System Folder) . Hard disks allow you 
to store your applications and documents all on one disk 
instead of o n a lot of separate floppies, making it much 
easier and faster to work. It is essential now to have a 
hard disk, as applications and d ocuments are rapidly 
outgrowing even the double-sided disks. 

In fact, a hard disk holds so much data that it's not even 
measured in kilobytes; it' s measured in megabytes, also 
known as megs. You 've already figured out that one 
megabyte is 1024 kilobytes, right? Right. 

Now, 1024 kilobytes (one megabyte) is more than what 
one floppy disk can hold. Hard disks come in various 
sizes, able to store from 20 megs to 30 to 40 to 60 to 80 
megs of information , and they're getting biggerla ll the 
time. So on a small hard disk then, say 20 megs, you have 
as much storage space as on more than 25 floppy disks! You 
can load all kinds of applications onto your hard disk and 
create all kinds of documents without having to fiddle 

Hard Disks 

·Megabytes 

• ApfJTOximalely 1000 K 
. equals one MegaiJyle 

7 
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· with putting floppies in and out. As the software applica­
. tions get more and more sophisticated, they take up 
. more and more space, and already there are applications 
· that just can't be used without a hard disk. 

Backup Disks . Always backup your software applications. As soon as 
· you buy a new application , make a copy of all the disks 
· and use the copy; keep the originals safe in a clean, 
· dust-free place. That way if a catastrophe happens to 
: befall your application that you paid so much money for, 
. you always have an extra copy. Software companies won't 
· give you a new copy if you destroy yours. Funny . 

. Also always make sure you have a current backup copy 
· of everything on your hard disk-all your documents you 
· have so laboriously created. A hard disk can "crash" and 
· leave no survivors. At the end of each working day, or 
: more often if it is really important, make copies (page 
. 35) onto disks of everything you created or modified that 
· day (label the disks!) . 

. You certainly don't want to completely lose all that data . 

. A hard disk comes with a back-up application- be sure 
· to check it out. If you are in a situation where there are 
· massive amounts of information to backup regularly, 
: check into the systems designed specifically for the 
. process. 

Rule Number 3 : Back Up Often. Like everday. 

· (No, you didn't miss Rules 1 and 2-Rule 1 is on 
: page 63; Rule 2 is on page 42.) 



The Mac turns on with a little switch on the back left of 
the machine-admittedly a very inconvenient place. A 
Mac II, though, can also be turned on with either the big 
key with the triangle on it at the top of the SE keyboard 
(that key that is useless for everybody else), or the key on 
the top far right on the extended keyboard. It's recom­
mended on a Mac II that you always use the keyboard for 
turning it on and off, rather than the switch on the back. 

If you have an int£Jmal hard disk for your machine, as soon 
as you turn it on it will boot up from the System on the 
hard disk. (The term "boot up" comes from the idea of 
pulling itself up by its bootstraps, as the Mac is going into 
its own System and turning itself on.) 

If you have an ext£Jmal hard disk, that piece of hardware 
should be turned on first, and then turn on your Mac. 

If your computer has any other switches for turning it on, 
either on top of the monitor or on the keyboard, the 
switch on the back of the Macintosh must always be 
turned on as well (see page 91). 

If you don't have a hard disk (you can read a little about 
hard disks on page 7), then you must insert a floppy disk 
with a System Folder on it. The System Folder, whether 
it is installed on your hard disk or stored on a fl oppy, 
must have at least two icons in it: the System icon and the 
Finder icon. Without those two items in the machine, it 
can 't start itself up; it will spit out any other disks you try 
to insert and wi ll give you the sad-Mac face. In fact, if 
those two icons are inside a folder, the folder must be 
named System Folder or Mac can 't find them. 

The System and the Finder are sort of like this: You are 
going on a trip. Your car is full of gas. You have the keys. 
You put a key in the ignition and start the car; the engine 
hums. But you can't get to where you're going yet-your 
car will sit in the driveway all day humming away until 
what? (Go ahead-think a minute.) Until you put it in 
gear. And that's sort of like what the Mac does: Your 
machine's plugged in. You turn it on. T he screen gets 

CHAPTER Two 

Turning It On 

Internal Hard Disk 

External Hard disk 

Other Switches 

System Folder 

LiJ 
System Folder 

The System and 
· The Finder 

rn 
~ 

System 

rn 
~ 
Finder 
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STARTING UP 

bright and that little picture is flashing. But you' re not 
going to get anywhere until you put it in gear by inserting 
a System and a Finder (the Finde r runs the Desktop). 

Inserting a Disk : If you are not working from a hard disk, then the System 
disk is inserted into the internal drive (th e drive is the 
li ttle slot in the machine that takes the disk) . Disks go in 
with the label-side up (the side that does not have the 
round metal piece on it), and the metal end goes in first. 
Your application, or program disk, then goes into the 

System and 
Software 
Versions 

external drive (usually a little box that sits on the right 
side of the computer). You can save data onto either 
disk, provided there is enough room. (Some Macs have 
two drive slots on the monitor; in that case, put the 
System disk into the top slot and the application disk 
into the bottom one.) 

If you ' re working from a hard disk, then your appli ca­
tions are probably already inside the computer and you 
won 't need to insert any other disks to access them. 

· You ' ll be inserting disks to save back-up copies or to 
install o ther fi les onto your hard disk. Either way, on the 
right side of the screen you will see icons, or pictures, of 
the start-up d isk and any others that have been inserted 
(see Chapter 8 for more info on icons). 

Whichever disk icon appears on you r desktop in th e 
upper right corner is the start-up disk, the disk that holds 
the System Folder the Mac was booted (started ) with. 

Al l computer software is constantly being upgraded and 
updated, making them more efficient, powerful, magical. 

· The developers le t you know which upgrade you have by 
· labeling them with version numbers. At the moment of 
. this going to press, the Macintosh Syste·m version is 6.04; 
. the Finder version is 6.1. 

: As the Systems upgrade, the software programs are 
created to work with the particular nuances of the newer 
System, so it's a good idea to keep up on them. Although 
you don ' t have to use the newest System, it's free, so why 
not take advantage of it? 

Only One System · There should never be more than one System in the 
per Computer! · computer. Certain circumstances will cause the Mac to 

switch from one System to another, invariably ending in 
a bomb (see page 93). 

10 



The Desktop is what you see on the screen when you 
first boot up your Macintosh; it's also known as the 
Finder. Consistent with the Mac environment that 
analogizes everything to parts of our real life, this Desk­
top works much the same as your desktop at ho me or in 
your office. You have desk accessories (under the Apple 
menu) such as a calculator, a clock, and a note pad ; you 
have a filing cabine t (the disk) that stores all your fi le 
folders fu ll of information; you have as many file folde rs 
as you could possibly want to organize it all; you can put 
folders inside of folders inside of folders ad infinitum 
(well, about 12 layers anyway) just like you would organ­
ize your hanging files. You even have a trash can. 

It's a good idea to keep your Desktop organized, just like 
you would your office desktop. Create new folders (from 
the File menu; also see page 31) for each category of 
informatio n , and store all applicable files in it. If you 
create a new fo lder at the Desktop uc::fon: you bc::gin work 
in an application, then you can put your new document 
right into that folder when you Save (see page 33)-that 
way, when you come back to the Desktop, everything is 
organized and in its folder so nothing gets misplaced. 

Whenever you Quit working in an application, Mac 

• File Edit Uiew Special 

CHAPTER THREE 

· The Desktop 
· or Finder 

automatically takes you 
back to the Desktop. If 
you don 't see the name 
"Special" in the menu, 
or if there is no trash 
can, you are not at the 
Deskto~you are still in 
the application . To get 
to your Desktop, from 

::::: : :::::: : ::::: : :::::::::::::::::: c:=t :: 

the File menu choose 
"Quit," no t "Close." 

The Desktop; 
also known as the Finder 

: : : : : : : : : : : : : : : : : : : : : : : : : : : : : : : : : : : : : H.a~d. D.ls.k: : 

::::::::: :::: : ::::::::::::::::::::::::: .... ::: ... . .... .. . . .. ... ...... ...... . . . ........ . ... 

: : : : : : : : : : : : : : : ! : : : : : : : : : : : : : : : : : : : : : : rr~sh : : : 

11 
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Organizing . Below is an example of a neatly organized Desktop 
Your Desktop . window, utilizing the hierarchal filing system (HFS), which 

. is a fancy way of saying folders-inside-of-folders. Each 
· category of software or documentation has its own place, 

and inside these folders may be other folders, each 
: compartmentalizing specific data. It's much easier to 

keep things organized on a Macintosh Deskto p than it 
is on an oak desktop. 

D Hard Disl< 0 
12 it~ms 1 8 ,334K in disk 838K availabl~ 

LiJ CJ CJ CJ 
Sy st~m F o ld~r Utiliti~s Programs Fr~~lanc~ 

CJ CJ CJ CJ 
Publications Invoicing Fishing TapDanc~ 

CJ CJ CJ CJ 
Robin Jimmy Ryan Scarl~tt 

K;ll 

A hard disk window on the Desktop, using the folders 
to organize all the files 

~ 

IQ 
10 Q] 



The mouse, of course, is that handy little piece of 
hardware that controls the movement of the cursor on 
the screen. As you move the mouse across the desk, the 
cursor moves across the screen in the same direction. 
In most Macintosh applications, you cannot fully utilize 
the program without the mouse. A few programs give 
you the option of doing absolutely everything from the 
keyboard if you choose; but why learn 450 keyboard 
commands-isn't that exactly what we' re trying to avoid? 

The mouse is used in several different ways: 

CHAPTER FouR 

The Mouse 

A single-click is a quick, light touch on tl1e button of the Single Click 
mouse, with the cursor (be it a pointer or an 1-beam or 
anytl1ing else) located at the spot of your choice on the 
screen . 

A single click with the arrow on an icon at your 
desktop will select the icon; a single-click of the 
!-beam will set down an insertion point. 

A double-click is a quick click-click on the button , again 
with the cursor located at the appropria te spot on the 
screen. A double-click has to be quick and the mouse 
must be still , or it will be interpreted as two single clicks. 

Double-clicking on most fi les will open that fi le; 
double-clicking on a word will select that word for 
editing. 

A press is simply pointing to something and holding the 
mouse butto n down. 

Pressing with the pointer on the menu lets you see 
the commands under that item; pressing on the 
arrows in a scroll bar scrolls th rough that window. 

Press-and-drag is to point to the object or ilie area of 
your choice, hold/press the mouse but/on down, and dmg 
across, letting go when you reach your goal. 

Choosing menu commands is a press-and-drag 
function; dragging icons across the screen is a 
press-and-drag function; selecting text is a press­
and-drag function. 

Double Click 

Press 

Press-and-Drag 
(also known, 
misleadingly, 
as click-and-dmg) 

13 



THE MousE 

14 

The Pointer : When you ' re using the pointer , remember tha t the part 
. of the pointer tha t does the trick is the very tip, called the 
. "hot spot." So be su re that the extreme point is in the 
· area you want to do someth ing to. 

: The hot spot ... . ... ~ ~ 77~e tijJ of the pointer 
~ does the trick. 

Cleaning · It's important and easy to keep your mouse clean. As 
the Mouse · you're ro lling it around you can feel if any cat hairs or 

: dustballs have gotten inside. Take it apart regularly and 
. clean it, following these steps: 

l. Take the mouse in your hand and turn it 
upside-down. 

2. With your thumbs, slide the rou:>d wheel to the 
left until the little marker on the wheel poin ts 
stra ight up to the "0 " (those little symbols on the 
back of the mouse actually are an "0 " and an "L" 
for Open and Lock). This will open the lid. 

3. Turn it b<tck over into your left hand so the lid 
and the ball fall o ut into your palm. 

4. You can clean the ball with a soft , dry cloth; clean 
the ro llers inside with a cotton swab dipped in 
rubbing alcohol. 

5. When clean, put the ball in your left hand; with 
your right hand place the mouse on top of the ball 
and fl op your hands over. This places the ball 
safely into its little cubby. 

6. Put the lid back on and twist it to the right, lining 
up the marker with the "L" for Lock. 

7. That's it! 



Across the top of the screen is the menu. This is called 
a pull-down menu, because when you point to a menu 
item and press the mouse button down, a list of menu 
commands drops down. 

~[--• ___ r_il_e __ E_d_i_t __ u_ie_w ___ s~p_e_c_ia_I ____ ~I-
The Desktop Menu 

To choose an item in the menu, simply keep the mouse 
button pressed and slide the pointer down; you' ll notice 
that certain commands become highlighted , or selected, 
as you pass over them. When the command you want is 
highlighted , just let go of the mouse button-don't click! 

In some programs the pull-down menu itself contains a 
pop-out menu where you not only slide down, but also 
out to the side, usually in the direction of the arrow. 

In the list, you can see that some commands are in 
black letters and some commands are in grey. When 
a command is grey, it means that particular item is not 
available at that moment. 

The most common reason for it not to be available is 
that something was not selected before going to ihe menu; 
for instance, you cannot choose "Open" from the File 
menu if a disk or fi le hasn' t been selected to be the one 
to be opened (to select something, click once on it). 

CHAPTER FIVE 

Pull-Down 
Menus 

Choosing a 
Menu Item 

New Folder 
Open 

Get Info 
Ejec t 

Pop-Out Menus 

Size 
Style Geneuo 
Al ignment • Heluetico 

Monaco 
Times 

Grey vs. Black 
Commands 

New Folder 
OtiC !I 
Ch1~ 1~ 

Cic!l Info 
Eject 
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Keyboard 
Command 

Shortcuts 

· To the right of the commands in the pull-down me nu 
: you often see a little code, such as 3€ N. This is a key-

board shortcut you can use insteml of using the menu. ···L---, · If you hold down the Command key (the one with the 
· cloverleaf symbol on it: 3€) and press the letter associated New f older XN 

Open X O 
Get Info X I 
Ejec t X E 

· with it, then the computer reacts just as if you had 
· chosen that command from the menu. For instance, at 

the desktop pressing 3€ N will give you a New Folder in 
the active window (page 19), just as if you had chosen 
that item from the menu with the mouse. 

· The people who designed th e Mac interface have been 
· very thoughtful- as many as possible of the keyboard 
· sho rtcuts are alliterative: 3€ 0 Opens fi les; 3€ P Prints; 
: 3€ E Ejects; SCW closes Windows; e tc. Also see the 
. following chapter. 

Ellipses •.. : Anytime you see an ellipsis (the three clots: ••• ) after 
& Dialog Boxes . a menu command (as in "Open ... "), it means you will 

· get a dialog box. There are different varieties of dialog 
boxes, such as alert boxes or message boxes, but basically 
they all are meant to communicate with you. 

Dialog boxes always give you an option to Cancel, so it 
is quite safe to go exploring menu commands this way. 

: Just choose a command , check it out, then click Cancel. 
Even if you clicked around on buttons or typed in the 
dialog box, clicking Cancel will make sure none of your 
changes are put into effect. 

Saue publication as l:j<H t 1 n OK J) 

I= Hard Dislc I Drlue l (Cancel J 

0 Freelance ~ = Hard Dislc 
0 lnuoiclng 

7 0 MacBasics 
0 PM3.0 
0 Programs 

Q 
Saue as: 

0 Publications ® Publication 
I New Document I Q Template 

A "Save as . .. "dialog box; notice you can Cancel. You could also 
choose lo eject a floppy dish before you Cancel if you need lo swajJ dishs. 



IMPORTANT 
KEYS 

CHAPTER S IX 

There are several keys on the Macintosh keyboard The Keyboard 
that are particularly important and useful. They come 
in handy for shortcuts, manipula ting images, accessing . 
alternate characters, and any number of things in specific . 
applications. 

Speaking of keyboards, there are basically three kinds for 
the Mac: the two standard keyboards with the keypad at 
the end (like a ten-key adding machine)- one version 
for the Mac Plus and o ne for theSE-and the extended 
keyboard that has all the function keys and other li ttle 
arcane sets of keys. Often people think the standard 
keyboard is the extended one because it has the keypad 
that we didn't have on our typewriters. It isn ' t. Both the 
Mac Plus and theSE generally have standard keyboards, 
but there are several keys that are placed differen tly, 
depending on which model (SE or Plus) you have. No 
matter where they are placed, though, they all have the 
following keys. 

The symbol noted under each heading is the symbol that 
appears in menus to indicate pressing that key. T hey are 
usually used in combination with letters- always hold 
down all the descrip tor keys (Command, Shift, e tc.) and 
give a quick tap on the le tter key associated with it. For 
instance, to Open fi les the command is often "3C -0": 
hold down the Command key while typing a quick 0. 

The Command key is o n the bottom row, the key wi th 
the California freeway cloverleaf symbol on it: 3C . On 
theSE and extended keyboards it also has an apple on it, 
and you may hear it referred to as the "Apple key." The . 
symbols you see in the menu are refer ring to tl1is key, and . 
most applications have keyboard shortcuts utilizing it. 

Next to the Command Key is the Option key. It's often 
used in combina tion with the Command key and/ or the 
Shift key. It's through the Option key that you access the 
special characters, such as¢ and ®, as well as accent 
marks, as in resume and pinata (see page 46- 49). 

The Backspace key, called Delete on theSE and the 
extended keyboards, is located on the upper right. The 
name was changed to Delete because that 's bas·cally 

Command Key 

a€ 

Option Key 

Backspace or 
Delete Key 
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· what it does- whatever is selected will be removed when 
. the Delete key is hit; whatever letter is to the left of the 
. insertion point will be dele ted as it is backspaced over. 

Tilde Key : The Tilde key ( ... ) is located on the upper left on the 
... . Plus keyboard, and next to the Spacebar on theSE and 

Escape Key . extended keyboards. It's often called the Undo Key, 
esc · because in certain applicatio ns it will undo the action 

· immediate ly preceding. Although on the SE and the 
: extended keyboards the upper left key now says esc 
. (escape) and the Tilde has been placed next to the 
. Spacebar, in many applications esc can still be considered 
· the Undo key because it often does the same thing. 

Control Key . The Control key, found only on the SE and Mac II key­
. boards, doesn't do much yet; in most applications it's 
· j ust a dead key. They say it's something we' ll grow into. 
· You can type the Command key symbol with it: in the 
: Chicago fon t Control-Q will produce 3€. 

Return Key · The Return key is often used for other procedures than 
: simply starting a new paragraph. For instance, any 
. button in any dialog box that has the double border 
. around i t can be activated with the Return key instead of 
· the mouse. Different programs utilize it in different ways. 

Enter Key . The Enter key on the keypad wi ll also activate buttons 
~ · with the double border, just the same as the Return key 

· as noted above. Again , different programs utilize the 
: Enter key in different ways. 

Spacebar · The Spacebar is represented in menus by either the 
._. · symbol shown to the left, OT as a blank space. That' ll 

· really throw you. How long does it take to figure ou t 
: that D 3€ means press the Shift key, the Command 
. key, and the Spacebar? 

Shift Key : The Shift key is one of the most common keys used in 
Lf keyboard shortcuts, symbolized by an up arrow. 

Caps Lock 

! 
· Just a note: the Caps Lock Key does not act just like the 
· shift lock o n a typewriter-in Caps Lock you get capital 
: lette rs, yes, but you do not get the characters above th e 
. numbers or above the punctuation. If you want the shift­
. characters you must still press the Shift key to get them. 
· Some keyboard shortcuts will not work if the Caps Lock 
· key is down, so check for that if you 're having problems. 



CHAPTER SEVEN 

A window, as shown be low, is a basic, fundamental Windows 
interface of the Macintosh. If you concep tualize your 
disk as a fi ling cabinet in which you store all your work 
in manila folders, then opening windows is like opening 
file drawers to see what's in the cabinet. It's important to 
know all the litt le tricks in using a window, as you 'll find 
windows in almost every applicatio n. They're sim ple . 

Title Ba Zoom 

Hard Disk 
Information 14 items 1 7 ,596K in disk 

Scroll 

LlJ LJ LJ LJ 
Box 

System Folder Utilities Programs Freelance 
Grey 
Scroll 

Icon LJ LJ LJ Bar 

Hypercard lntro/Work Pagemaker Publications 

Size Box 

Scroll 
Arrow 

Hidden 
Icon 

The title bar is the area at th e top of the window in 
which , logically, the title appears. T his title refers to the 
disk, folder, or d ocument you have opened. If you press­
and-drag in the title bar , you can move the window 
around the Desktop; it moves as an ou tline. just le t go 
when you have the outline placed where you want. 

If you have more than one window open , only one 
will have lines in its title bar; this means it's the active 
window. If the windows are overlapping, the ac tive 
window is the one that is foremost. 

The active window is the window tha t the commands 
from the keyboard or the menu will affect; for instance, 

Title Bar 

Moving the 
Window 

Active Window 
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if you go to the File menu and chose "Close," it will close 
the ac tive window. If you ask fo r a "New Fo lder ," the new 
fo lde r will appear in the ac tive window. 

: To make a window active, simply click on any visible par t 
. of it; this will also bring that window to the front of any 
· others. You may have to move o ther windows around in 

orde r to see the window you wan t to make ac tive . 

. ' To move a window without making it active, ho ld 

. e down the Command key while you press-and-drag 
in its title bar. 

. Sometimes you can ' t see the window itself but you can 
· see the grey icon; in that case, double-click on the grey 

icon to br ing i ts window forward and thus make it active . 
(Also see pages 27 and 73 regarding grey icons.) 

O n the bo ttom right corner is the si:ze box. If you 
press-and-drag in the size box, you will make the window 
larger or smaller. 

On the upper right corner is the :zoom box. If you click 
in the zoom box it will enlarge to fil l almost the en tire 

. Desktop. If you click in it when it's large, the window will 
· zoom back down to the size it was just before you zoomed 
· it larger. 

· Alo ng the right and bottom edges of the window are the 
scroll bars. The scroll ba rs allow you to view everything 
in the window, even if it cannot all fit on the Desktop 
or if the window is sized too small. You'll notice in the 
example on page 21 that the scroll bar along the right 
side is grey, while the one o n the bo ttom is white. 

. When a scroll bar is grey, it's indicating tha t there are 
other ite ms in the window you can 't see. In the example 

· on the previous page, you can see a fo lder along the 
· Luttum edgt that is b arely visiult , su the scroll !Jar is 
: grey, telling you some thing more is beyond its borders. 

· V\'hen the scroll bar is white, it' s indicating there is 
: nothing more in th e d irection of the arrows (the hori-
. zon tal direction in the diagram) than what you can see. 

: At e ither end of the scro ll bars are the scroll arrows. 
. When the scroll bar is grey you can press on a scroll 
. arrow, making the conten ts of the window glide past 
· you as the scenery outside a tra in window. 



Notice the little scroll box in each scro ll bar- as you 
press on the arrows, this box moves so you can see where 
you ar e in the window. When the box is all the way at 
one end, that's the end of the window. 

Another thing the scroll box is useful for is this: if you 
press-and-drag the scroll box, you can move it to any 
position on the scroll bar, let go, and the window will 
immediate ly jump to that particular place rather than 
scrolling through everything. This is very handy inside 
an application where you have a long document and 
scrolling with the arrows would take too long. In some 
applications a number appears in the scroll box to 
indicate what page you 're on. 

There's yet another way to use the scroll bars: if you 
simply click the pointer in any grey area of the bar, 
the window will move up, down, or across, usually a full 
window view- what was at the bottom of the view will 
then be at the top or vice-versa. 

Just under the title bar you ' II find some very useful 
information: if your window is showing icons, you ' 11 see 
how many items are in that window, how much space is 
being used up o n the disk, and how much space is left on 
the disk. On a hard disk, the numbers are still referring 
to kilobytes, so just round it off to megs by referring to 
the number in the thousands place (e.g. 7,856 would be 
almost 8 megs). If your window is not showing icons, then 
the information bar indicates how your fi les are currently 
being organized (see "Viewing the Window," below). 

And, of course, in the upper left is the close box. 
Clicking once in that little box will close the window for 
you, sending it back to the disk or folder it came from. 

Macintosh always tries to allow things to happen in a way 
that you feel is most workable for you. The view of the 
window is another good instance-you can choose to 
see what's in your folde r in a variety of ways, all appro-
priate fo r different purposes or styles. I 

These different views are found, of course, in the View 
menu when you ' re a t your Desktop. When you choose 
one, the active window wi lJ appear in that choice (the 
active window, remember, is the one that has thtj lines 
in its title bar). T he view will stay that way unti l you 

WINDOWS 

Scroll Box 
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D change it. As you change the views, you'll notice the name 
of the view you have chosen is underlined in the window. 

t=== ====== · While viewing the files as text, you can still manipulate 
· them just as if they were icons (i.e. pick them up and put 

them in the trash or in another folder, rename them, 
copy them, open them, etc.-see Chapter 8 on Icons). 

Name-

D ChHdre-n 

D F reo eo lance-

D HC Book 

D Hype-rcard 

D lntro /Works 

D Tap Dance-

D Utilitie-s 

Notice the underline in 
the infomzation bar 
indicating which view 
is being shown 
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. View by Small Icon keeps that feeling of looking at 
· pictures, if that's what you prefer, but the icons are tiny 
· so you can fit more in the window. They're no t in any 
: specific order. 

· View by Icon is what you typically see-pictures 
· representing the data. Visually-oriented people tend to 
: prefer this style. Again, the files are in no specific order. 

· View by Name turns the icons into text for those who 
: prefer looking at words rather than pictures. A tiny little 
. icon is still present so you can see what sort of file it is. 
· They're arranged in alphabetical order by the name of 
· the file . 

. View by Date organizes the files in a text format, in 
· chronological order backwards from the date they were 
· last modified, not the date they were 01iginally created. 
: This is handy when you have, for instance, several budget 
. documents and you want to see the most recent version . 

: View by Size organizes the files in text form in order of 
. size, beginning wi th the largest. It tells you how many K 
. (kilobytes) that particular file is taking up on your disk. 
· This is handy if you need to remove something to make 
· room; you can see which files to remove to clear enough 
: space. Unfortunate ly, it won't show the size of folders; to 
. find their size you need to select the folder and choose 
. "Get Info" from the File menu (see page 29). 

: View by Kind organizes the files by whether it is an 
. application, a document, or a folder. This is handy if 
· you want to see a list of all your applicatio ns, or all the 

documents in your budget folder, etc. 

' View by Kind is particularly useful for a folder 
• that holds an application and all its accessories­

dicti onaries, tutorials, technical files, samples, 
e tc. This view will always put the application itself 
at the top of the list so it's easy to find. 



WINDOWS 

When you 're viewing icons in your window, they1 often 
get all scrumbled up and look like a mess. To a lign them 
all nicely, simply choose Clean Up Window from the 
Special menu- all the icons will fly to the nearest little 
cubby available on the underlying invisible grid. 

When they fly to the nearest spot on the grid, 
though, there are often spaces left available 
where another icon could fit in . lf you want 
them to all line up in rows, from left to right 
wi th no empty p laces, ho ld down the Option key 
when you choose "Clean Up Window." 

If an icon is selected , then the menu will say "Clean Up 
Selection ," in which case just that selected item will be 
straightened up. Older systems may just say, "Clean Up." 
It works the same. 

This is the button all houses must have- the dishes jump 
onto the ir shelves, the laundry puts itself away in the 
drawers, and all the toys go back in the toyboxl 

·Clean Up 
:Window 

' • 

T o close all the windows that are open on your Desktop, · Close All the 
hold down the Option key while clicking the active · Windows 
window's close box; they' ll all go away one after another! 

If you have System 6.0 or highe r, you ' ll notice in ' 
the File menu the re is a keyboard command for • 
closing the active window: Command-W. If you 
want to close all the windows a t once, press 
Command-Option-W and all the windows will 
fly away home. 
Note: This will not worh if a Desh Access01y is the active 
window; nor will it woTh if the CajJs Loch key is down. 

Another fancy trick to close all the windows is ' 
to hold down the Option key when you choose • 
"Quit" from any application. Keep holding the 
Option key down until you see your Desktop. 
When you arrive, there won't be a single widdow 
open. If you use this trick you can legitimately 
call yourself a Power User. 

Often the file you want to open is buried within ' 
several folders. H old the Option key down while • 
double-clicking to open those folders; when you 
return to the Desktop they will already be closed. 

23 
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Print the · Occasionally you may have a need to print the informa­
Window : tion you find in a particular window; for instance, to 

on an . make a list of all the documents that are o n that floppy 
lmageWriter · disk, or all the dated budge t files that are in the Budget 

· fo lder. You can only do this on an ImageWriter, though. 

· To print the info in the window: 

• Turn on the Image Writer, making sure the 
Select light is on. 

• Make sure the window you want the data from 
is the active window (click on it). 

• Hold down the Command and Shift keys and 
press 4 (Command-Shift-4); when the printer 
responds you can let go. 

Print All · The above procedure prints only the visible contents of 
the Windows · the active window; if you want to print everything on the 
on the Screen : screen, the whole screen and nothing but the screen , 

. th en do the same as above but this time press the Caps 

. Lock down before you press Command-Shift-4. This way 
· you can print the contents of any and all open windows 
· whose contents a re displayed. 



Icons- the little pictures you see on tl1e screen-are 
another intrinsic part of the Mac interface. Instead of 
having to type in a code to get into an application or 
document, you simply click on the icon representing it. 

A no te about clicking on icons- if you're trying 
to select o r open it, don't click on the name, or 
tl1e icon thinks you want to change tl1e name. 

When you initially turn on your machine and get to the 
Desktop (as on page 11 ), you ' II always see an icon o f the 
disk you 're using, whether it's a hard disk or a floppy 
(tl1e hard disk icon may look different ilian this one 
shown , depending on where it is and what kind it is). 

• Single-clicking o n a disk icon will select it. 

• Double-clicking will open it to show you a 
window holding all the files. 

Note: If a disk icon is grey, it is ei the r already 
open (page 27) or has been left in RAM after 
being ejected (page 73) . 

Whenever you have a window open , most likely you' ll 
see folder icons. They act just like folders in your filing 
cabinet. Be sure to read the fo llowing chapter o n 
Folders, as they are an important organizational. tool. 

• Single-clicking on a folder will select it. 

• Double-clicking wi ll open it to show you a window 
with all the files that are stored in that folder. 

Inside the fo lder named System Folder are all the system 
icons iliat he lp run the Macintosh , as well as a varie ty of 
icons tl1at are for exu·a or fancy options. The ones iliat 
look like little Macs are system icons that perform 
essential operations. You'll see one called System and 
one called Finder- if those two are not inside L~Je System 
Folder, you won ' t even be able to use your machine. 

• Single-clicking o n a system icon will select it. 

• Double-clicking will give you a message telling you 
an application can 't be found or that it is locked 
or in use. That's because system icons are just visual 
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representations of the data on your disk that makes 
them work-there's really nothing to look at besides 
the cute little icon. 

. Also in your System Folder are printer icons. In order to 

. print to any printer, you must first have the icon inside 
· your System Folder. If it is not in the System Folder, then 
· when you go to the Chooser (see page 79) to tell Mac 
: which printer you want to use, there will be nothing to 

designate and you won't be able to print. 

• Single-clicking on a printer icon 'viii select it. 

• Double-clicking will give you the same message 
as the one you get with the system icons, for the 
same reason. 

· The application or software icons are the fancy 
· ones. T hese belong to the application, or the software 
: program, itself. Each application has its own design, 
. so they all look different, but what they have in common 
. is that they all try to give some sort of visual clue as to 
· what they do. For instance, in the icons to the left you 

can see that MacPaint is an art program; Microsoft Works 
combines word processing, database, spreadsheet, and 
telecommunications. 

• Single-clicking o n an application icon will select it. 

• Double-clicking will either open up to a new, blank 
page within that program, or at least to a dialog box 
where you can choose to create a new, blank page. 

Document icons represent documents, or files, you have 
created in any particular application. Whenever you are 

: working in an application and you save your document 
. wi th a title, a document icon is created for you on your 
. Desktop . 

. Document icons almost always look like a piece of paper 

. with the top right corne r folded down, or perhaps a 
· sheaf of papers or a stack of cards. Typically they have 

some resemblance to the application they were created 
in, as you can see by the Works and MacPaint icons on 
the le ft. 

• Single-clicking o n a document icon will select it. 

• Double-clicking will usually open you up to the 
application it was created in, with that particular 



document on the screen. (If you get an error 
message, check page 92, "Can ' t open a fi le.' ) 

When an icon is grey, as th e one on the right, that 
means it's already open. Maybe you don't see its window 
because it's hidden behind another open window, but 
you know it's open somewhere. (If a floppy disk icon is 
grey, but it is not in the machine, see page 73!) 

• Single-clicking on an open icon will select it. 

• Double-clicking will bring its window to the front 
as the active window. 

When an icon is black, like the one on the right, that 
means it is selected-it got selected by clicking on ce on 
it. Once an icon is selected , you can press-and-d rag it 
somewhere; menu commands will affect it, such as Open 
or Put Away or Clean Up Selectio n; you can change its 
name by typing. 

• Single-clicking is what selected this icon in the 
first place. 

• Double-clicking a selected icon wi ll open it just 
like any other icon. 

The trash can icon works j ust like the trash can in your 
yard- you put things in it you don 't want anymore and 
the garbage collecto r comes and takes it away and you 
never see it again. 

To put something in the trash: Press-and-drag an icon 
ove r to it. When the can becomes black, le t go and the icon 
will drop inside . If you find a bunch of garbage hanging 
around outside the can , it 's because you didn ' t wait for 
the can to turn black-you just set it down next to it. 
Try again. T he tip of the jJoinler must touch the can! 

To remove something from the trash: If you double­
click on the trash can you' ll find that it opens up to a 
window, just like any othe r \Vindow. So if you decide you 
want that item you just threw away, you can go get it. 
Either press-and-drag the icon back to the disk/ folder it 
came from; or click once on it to select it, then from the 
File menu choose "Put Away" and it will go right back 
where it came from. How does it know? 

Don ' t coun t on anything staying in the trash very long, 
though ! Read on ... 

:Open (Grey) 
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· You can empty the trash by going up to the Special 
. menu and requesting "Empty Trash ." O nce you do that, 
. it's gone forever. o amount of crying or pleading or 
· screaming or kicking will bring it back. Believe me. 

·ow, you can empty the trash yourself, as noted above. 
· But sometimes the garbage collector comes when you ' re 
· not looking, so don' t count on it staying the re ' til you 
· empty it. Whenever you eject a disk, copy a file, Shut 
: Down, Restart, or turn off the computer, th e trash gets 
. emptied . Whenever you open an application, the trash 
· gets emptied . Whenever the power goes o ut, even for 
· a split second, the trash gets emptied . And if the Mac 
· runs out of RAM (random access memory, where every­
: thing stays until it gets saved to a disk), Mac herself will 

empty the trash for you and take that memory space. So 
be careful. 

Whenever anything Mac thinks is important has been 
· put in the trash, such as an application or system icon, 
· you ' ll get a dialog box asking if you really want to throw 
· that away. That's nice. 

' If you don ' t want to see the warning dialog box, 
• hold down the O ptio n key while trashing the item. 

Unfortunately, Mac doesn ' t think anything you have 
: created is worth warning you abou t. 

When trashing items to make more space on 
the disk, the trash must be emptied before the 
space will open up; watch the numbers in the 
information bar of the window when you 
empty the trash . 

Screen Dump Occasionally you will see or create an icon that is named 
. Screen 0 or Screen l , etc.; th is is a screen dump. The 

Screen 0 
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· screen dump holds a picture of the compu ter screen 
at the time you pressed the special key combination. 

Whenever you press Command-Shift- 3, a MacPaint 
screen dump, or screen sho t, is created for you; an icon 
for the shot will appear in the window that con tains the 
System Folder. You can open MacPaint, open this file 
(or use SuperPaint with the MacPaint button in the 
Open box chosen), and view/ change the image just 
like you would any o ther pain t image. Then paste it 
into another document. 



For instance, all the images in this book were cneated 
using screen shots. With the image on the scree 1 in its 
natural habitat, Command- Shift-3 was pressed. Then 
MacPaint was opened and the Screen 0 file was opened. 
Since the screen shot took a picture of the entire screen, 
all the excess stuff around the image had to be erased. 
It could then be changed, resized, rotated, flopped, etc. 
The images were put in the Scrapbook and later pasted 
onto these pages. 

You can create up to 10 screen dumps, and they' ll be 
labeled 0 to 9; you can create more, but you have to 
rename the others first. 

Get Info is not an icon , but a menu item that can give 
you important information about any file represented by 
an icon on your Desktop, be it application, 
document, system, printer, or fo lder. D 

IcONS 

Get Info 

Info 

Select an icon , any icon , by clicking once 
on it; then from the File menu choose "Get 
Info." You' ll get a little information window 
that tells you interesting things about the 
file, such as how big it is, when it was made, 
which software program it was created in, 
which software version you have. 

~-· 
loclc:"d 0 g Re-vie-ws 

K;nd : PageMaker 3.02 document 
s;z.,: 1 7 ,664 bytes used, 18K on disk 

Yh"r" : Hard Disk, SCSI 0 

Cr.,at.,d: Fri, Mar 23, 1990, 2 :38 AM 
Mod;t;.,d: Fri, Apr 6 , 1990, 11 :15 AM 
Version : not available 

The nicest thing about this window is ' 
you can type in your own information e 
in the box at the bottom (the insertion 

Add Aldus and How reviews to list. I 

point flashes, waiting for you to type). This 
COJ!leS in very handy: you can write notes to 
yourself about that particular fi le and what it contains 
briefly detail this budget file from that budget file, 
record any bugs you find in it, make note of further 
changes you want to employ, leave no tes for your lover, 
etc. The information you type is automatically saved. 
(If at some point you chooose to rebui ld your Desktop 
[see page 89], the rebuilding process will unfortunately 
destroy any Get Info notes. Darn it.) 

The info on the followi ng page explains the little locked 
checkbox in the upper right. 

This is the box 
in which you can 
type you1· own notes. 
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Locking the File 

Locked ~ 
This file is now locked. 

: T he re is a locked checkbox in the upper right corner 
. of the Get Info window. If this is checked (by clicking 
. once o n it), the fi le cannot be renamed o r inadvertently 
· thrown away- as soon as it h its the trash a dialog box will 
· come up telling you a locked file cannot be thrown away. 

· It also becomes a Read-Only fil e- no one can save 
· changes in it. This is handy for sending around copies 
· of a document and ensuring no one acciden tally changes 
: anything. You can ' t even change the Get Info notes. 

: ' If you ho ld down the Option key, you can throw 
. • away a locked fi le. Uh oh. 

Locked D · To unlock it, simply click in the checkbox again . If there 
This file is now unlocked. : is no X, it is unlocked . 

Moving Icons 

Renaming Icons 
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Undo 
leon Name 

Change 

· To move icons, simply press-and-drag on them . You can 
· put any icon into any folder icon , and drag them out of 
: folder icons. Also see Chapter 10 on Copying/ Selecting. 

· To rename an icon, click once o n it. When it turns 
: black, simply type and the name will be changed. If the 
. name does not change, cl ick once more on the icon ; 
. sometimes it insists on two single clicks (not a double-clich!) 
· as a safety feature protecting you from changing the 
· name acciden tally. Use standard word processing 

procedures to set an insertion point, double-click a 
ward to select it, backspace to delete, etc., as detailed 
in Chapter 12. 

If you perchance do acciden tally change the name of an 
icon (which is very easy to do-fi les have been known to 
myste rio usly change their names to \\\\\\\\\\\\\\\ or ------

. while you weren ' t doing anything but leaning on the 
: keyboard), you do have one chance to restore it to its 
. original form: Undo. As soon as you see this mistake has 
. been mad e, fro m the File menu choose "Undo." If you 

haven't done anything since this minor catastophe (and 
· tl1ings could be worse), Undo wi ll restore the original 
· name, even if you fo rgot it. If you are too la te to catch 
: Undo, you ' II just have to rename it yourself. 



Folders are essential to the organization of your work 
on the Mac. They are, of course, visual representations 
of our office and home environment, and they function 
in much the same way. 

You can conside r your disk to be the main filing cabine t. 
Whe n you store items in a filing cabine t, you don ' tjust 
toss them in the drawer, do you? Can you imagine what a 
mess your filing cabinet would be without folders? Many 
Macintoshes become just as messy and just as difficult to 
find work in. It's very important to learn to take advan­
tage of the folders. 

You can create your own new, empty fo lders by 
choosing "New Folder" from the File menu, or by using 
the keyboard shor tcut, Command- N. The new folder 
will appear in the active window. 

The new folder shows up in the active window already 
highlighted , or selected (it's black), with the name 
"Empty Folder." Mac assumes you want to change the 
nam e, so while it is black you can just type the name you 
want it to have and the new name will appear. If you type 
an error, just backspace over it (use the Backspace or 
Dele te key in the upper right of the keyboard) and 
continue typing. Yo u can use up to 27 characters; you 
can ' t use a colon , nor can the name start with a period. 

If you accidently unhighlighted the new folder before 
you changed its name, or if you want to change the name 
of any othe r folder, it is sti ll very easy to do: simply click 
on the folder and it will turn black. You'll notice the 
pointe r changes from an arrow to an 1-beam when it's 
pointing to the name of the folder; this is a clue that 
whatever you type now will replace the title that is 
already there. So go ahead and type in the new name 
while it's black. 

If typing while the folder is highlighted doesn 't change 
its name, click once more on the folder; sometimes it 
insists o n two single clicks (not a double-click!) as a safety 
feature protecting you from changing th e name 
acciden ta lly. 

CHAPTER NINE 

Folders 

Creating a 
New Folder 

Naming the 
New Folder 

Changing 
the Name 
of a Folder 

The pointer has 
changed to an 
/ -beam 
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FOLDERS 

Putting 
Something Inside 

a Folder 

Opening a 
Folder 

Removing 
Something From 

a Folder 

Note: 

Moving os 

opposed to Copying 
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Organizing 
Your Disk 

Using Folders 

: To put something inside the fo lder, press-and-drag any 
icon over to it; when the fo lder turns black, le t go and 
the icon will pop inside. The fo lder does not have to be 
open to place an item inside of it, and it can be grey. You 
can have folders inside of folders inside of folders, wh ich 
is technically called the Hierarchal File System (HFS). 

Double-clicking on any folder will open it to a window, 
. showing you all the valuable informatio n you have 
. stored inside. 

· To remove something, open the folder first, so you see 
· its window and the icons inside, as below. Then simply 

press-and-drag the icon/ s out, either to the Desktop or 
to another folder or window. 

If you are moving th e icon to someplace else on the same 
disk, it will just pop out of that one folder and into the 
o ther. BUT if you are moving the item to a different d isk, 
the original icon will stay put and a copy of it will be 
placed on the other disk. 

Below is an example of a well-organized hard disk; there 
isn't a bunch of junk lying around making it difficult to 
find th ings. (Would that houses were so easy to keep 
neat! ) It's basically organized the same way a fil ing 
cabinet would be. 

=D Hard Disk t!l 
14 itPms 17 ,776K in disk 1 ,396K availablP 

00 CJ CJ CJ CJ 
~ 

Syst Pm FoldPr UtilitiPS Programs FrPPlancP Fishing 

LJ LJ LJ LJ 
Hypercard lntro/Work Clip Art Publications 

CJ CJ CJ CJ 
Robin Jimmy Ryan ScarlPtt 

K) 
0 1 10 12:1 

E vel)•thing on I he dish (the "ji ling cabinet ') is tuched into a f older; 
the f olders may each have sub-folders to furth er organize their contents. 



One of th e best ways to keep windows tidy is to create a 
specific new folder for a new project before you create . 
the documents for the project, and then save the documents . 
right into their own folder. For instance, if you are about to 
create a budget report with seven variations, or a news­
letter in which there will be ten to twelve separate stories, 
then follow these steps: 

• At your desktop, before you open the application 
to start creating the reports, make your new folder 
and name it (Jet's name this one BudgelNews). This 
new folder can be inside of another folder, of course. 

Hurd Dislc 
17 it•ms 17 ,454K in disk I ,71 BK availobl• 

~ 
A newfolderaltheDesktop I}] LJ LJ ';:;:; 
hard disk window, waiting Syst•m Foldor uttllttu Budg•t N•"'s 'lil' 

for the new sl01ies to be 0 
storrd i11Side. 0 L J'm'H!iU!'i''',iFj!;!,!j!!!:i!'i!l!•!i'!i:l!:! !!i:;i!i!i:HH!!;'H:h';!;'''i!:hl 0 '2l 

• Go into your application and create the first report. 

• vVhen you go to "Save As ... " and name the story, find 
the folder Budget News in the Save As dialog box. 
You ' 11 see the folder you created earlier listed here in 
the list box. Double-click on it to open the folder. 

ICJ Hard Disk I 
0 Budget News A. CJ Hard Disk: 

0 Fishing 
~ 1550K auailable 

0 Freelance I n S<Hl(~ ll 0 HC Course 
0 Hypercard 0 (Cancel) 

Saue Current Document as: 

I I 
' If you don I see the folder listed here, cbc/1 D1zve to see 

if it is on anotha disk. Or perhaps you havt' it tucked 
inside of anotherfolde~~ in which ca.1·p you will need to 
ojHm that other folder first. 

( 1: je( t 

( nritl(1 

I 
I 

) 

) 

FOLDERS 

Creating 
Proiect-Specific 
Folders 

l n this example 
here is the folde r 
IJudgetNews; 
double-clid1 on 
it to open it. 
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Make sure this label • 
shows the name • 

o!Jour folder. · 
you see the name of • If 

} 

bo 
•our folder in the list 
x beneath it, dauble-
lick on that name to c 
open the folder and 

make it apjJear here. . 
um you save, it will • 

always be saved into . 
whatever folder or onto • 
whatever disk appears 

in this label. 

• After you double-click on the name of the folder, you 
will see its name and an open folder icon in the labe l 
above the list box. If you choose to Save right now, it 
'vi ii be saved into that folder. 

• When you go back to your Desktop everything wi ll 
be right where it be longs, tucked in to its own folder, 
and nothing will be forgotten or misplaced. 

6l Budget News I 
c:~ Hard Disk 

Q 1706K auailable 

[ Saue D ( [ j(H t ) 

0 ( Cancel ) ( Bri t'(~ ) 
Saue Current Document as: 

I Budget Story # tl I 

If you refuse to read and follow the directions and have 
lost files, do read about Mr. Find File on page 81. He'll 

: go get them for you. 



COPYING/ 
SELECTING 

Copying fil es is an everyday task. You may need to copy 
an application from its original disk on to your hard disk; 
copy a report to give to a co-worker; copy a documen t 
to take to a service bureau for printing; create the ever­
necessary backup copy; etc. e tc. e tc. 

Macintosh has made it as easy as can possibly be to copy 
files (which is why pirating, or copying software without 
paying for it, is such a problem for software producers). 

To copy, simply click on the icon representing 
the file you want to copy; then press-and-drag 
the icon to the icon of the disk you want to copy 
it onto. A li ttle message comes up telling you it's 
being copied. That's it. 

You may copy onto a disk, into a folde r on another disk, 
or onto your hard drive. In every case, make sure that 
the icon of the place you are copying it into becomes 
black. When it is black, that means it's ready to accept the 
file/ s. If it's not black, you ' ll just be placing it next to the 
icon , not in it. The tip of the pointer is what turns it black. 

To copy more than one file at a time, select more than 
one file (detailed in the next paragraph); when more 
than one file is selected , dragging one file will drag them 
all together, either to the trash can , into another folder, 
onto another disk, or simply to clean up the joint. 

You may have noticed in a Desktop window that when 
you press in an empty space and drag the pointer, a dotted 
rectangle comes out of the tip-this is the selection 
marquee, common in many Mac programs. On the 
Desktop, any file that is even partially enclosed in this 
marquee will be selected. 

CHAPTER lEN 

Why Copy? 

Copying 

Copying 
More Than One 
File at a Time 

Selecting 
More Than One 
File at a Time 

' • 
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COPYING/SELECTING 

· Selecting all the icons this way will of course turn them 
all black. 

• When you press-and-drag on the blach area of one 
of the selected items, they will all drag togethe r. 

• Clicking in any white space will deselect a ll the files. 

Shift-Clicking · Another method of selecting mo re than o ne item is to 
to Select · Shift-Click. You may have noticed tha t once a file is 

More Than : selected , clicking on another file deselects the first 
One File . one. But, if you hold down the Shift key while clicking, 

•
• · every one of the files you click will be selected. This 

· way you can select several files in differe nt corners of 
: your window. 

Shift-Click to · In the same manner, you can deselect one fi le at a time. 
Deselect · For instance, if you group a bunch of files within the 

: selection marquee but you don ' t want the one in the 
. middle , simply hold down the Shift key and click once 
· on that one-it will be the only one deselected . 

Duplicate/Copy 
File on Same Disk 

· T he Mac o nly makes a copy of a fi le if you drag the file to 
· ano ther dish. If you want to make a copy of the file o n 

•• •• 

Copy From 
Floppy to Floppy 

with Only One 
Floppy Drive 
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: the same disk, click once on the file icon, then from th e 
. Fi le menu choose "Duplicate" (or press Command-D). 
· This creates a secon d version in the same fo lder named 

"Copy of __ ." When duplicating or copying folde rs, 
every item contained within is also copied. 

If you wan t to put a copy of a fi le into anotherfolder 
on the same disli, a shortcut is to hold down the 
Option key while moving the fi le . (This does not 
rename the fil e "Copy of __ .") 

If you want to kn ow how to copy from one floppy disk 
to another fl oppy disk when you have o nly one floppy 

. drive, please see page 89. 



OPENING 
APPLICATIONS 

Or Documents 

The term application is often used synonomously with 
program. It refers to the software package you are using 
to create your documents, such as Claris MacPaint, 
Microsoft Works, Adobe Illustrator, etc. They all do 
something different; they all have a particular function. 
Sometimes it takes a little research to find the software 
applications to specifically meet your needs. 

To open an application, or software program, find its 
icon on the disk. Application icons, as noted in the 
chapter on icons, typically look fancie r than anything 
else. Whether the program is installed o n your hard disk 
or you are using a floppy disk, you will need to find its 
icon at the Desktop. 

From the Desktop, double-click on the applica­
tion icon to open to a blank page, ready for you 
to create a new document. 

Some applications open to a commercial, or al 
least to an Open dialog box; in eithe r case you 
can choose to create a new document at th at 
point from the File menu. 

To open a document that has already been created and 
saved in an application, find its icon on your Desktop. 

Double-click on a document ico n; most of the 
time this will open the application, placing your 
document on the screen as you last saved it. 

A few programs won ' t allow you to open their documents 
from the Desktop. If the software program itself is in the 
computer, either on the hard disk or on a floppy, and 
you get the d ialog box telling you an application can't be 
found, then you must open the application first and then 
open the document from the File menu by choosing 
"Open." See the section on the following page for 
maneuvering around the Open dia log box. 

Now, just because you have an icon represen ting a 
document you created in a certain software application 
doesn 't mean you can open up that document just any­
where. Double-clicking on a document icon will only 

CHAPTER ELEVEN 

What is an 
Application? 

Opening an 
Application 

~ 
MacPaint 

Application icon 

Opening a 
Document from 
the Desktop 

Peaches 

DocU1nenl icon 

Important Note! 
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OPENING APPLICATIONS OR DocuMENTS 

open it IF the application itself is also in the computer, either 
on the hard d isk o r o n a floppy disk that is inserted into 
one of the drives. If the application isn 't there, then the 
document doesn ' t have anywhere to put itself! (See page 
93 for more info.) 

New vs. Open Once the application is up and running, in the File 
men u you see two choices: New and Open. This is 
confusing at first because one thinks, "Well, I want to 
open a new one." The difference is this: 

An 110pen11
• 

Dialog Box 

Folder names are black 
(not grey) because there 

may be a file inside that 
you can ojJen. • 

Single-click on 
one of these names to 

select that file. . 

Double-click tlte name . 
to open the file. • 

If it is a folder, as this · 

• New creates a clean, blank page on which to begin 
to create a new document. 

• Open takes you to a dialog box where you can 
choose to open a document that has been previously 
created and saved. 

This is the specific folder or 
disk the document is in. When 
the icon in the label here is a 
folder, this is a menu; press 
to see the hieraTChy. 

Freelance 
D Hypercard 
D I ntro/ Worl< 
D Jimmy 

Newsletter/ May 
D Programs 

Publications 

This is the name of the 
disk you '1e looking at. 

c:::=~ Hard Dis I< 

r j ~~ ~ t ) 

Driue ) 

Open 

Cancel 

one is, it will open here in • !.=======================~ 
this list box to show you : 

the files inside the folder; . 
if it is a dowment, it will • 

open that dom.mzent • 
on your screen . . 
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Click Eiect to eject a disk so you can inse1t another. 

Click Drive to see what's on the disk in the other drive. 

Click Open to ojJen the selected file; or you can double­
click on the file name. 

Click Cancel to take you back to whereve1· you were 
without opening anything. 



CHAPTER TWELVE 

In some applications typing is the main idea, as in a 
word processor. In some, it is the way to input the data 
whose purpose is to be manipulated, as in a database or 

· Typing 

a spreadsheet. In others, it is a sideline that is occasionally. 
necessary, as in a paint program. And everywhere you find. 
dialog boxes where you type in some answer or other, and · 
even on your Desktop you can type in the names of fi les 
and folders. Fortunately, in the consistent Mac enviro n­
ment, every program reac ts to typing in the same way. 

You may a lready be familiar with the Macintosh 
word processing 1-beam (pro nounced eye-beam): I 
In the Macintosh , the !-beam is a visual clue that you are 
now in a typing mode, as opposed to having an arrow or 
a cross-hair or any number of other cursors that appear 
in various programs. 

The /-beam is simply anotlzer pointer. And j ust like the 
pointer, it doesn 't do anything until you click it. 

When you move the I-beam pointe r to a spot and click, 
it sets down a flashing insertion point that looks like 
this: I (but it fl ashes). 

Mter you click the mouse and set the insertion point, 
then you can move the I-beam out of the way (using 
the mouse)-the insertion point is what you need to 
begin typing. With the insertion point flashing, anything· 
you type wi ll start there and move out to the right. T his · 
is true wheth er the insertion point is at the beginning or : 
the end of a paragraph, in the middle of a word , in a fi eld . 
of a dialog box, under an icon at your Deskto p, or any­
where else. (The only time the words will not move to 
the right is if the alignment has been set to align r ight or 
centered , or if a tab other than left-aligned has been set.) 
At any time you can take the mouse, move the I-beam 
pointer somewhere else, click it down, and start typing 
from the new insertion point. 

Also from that insertion point, pressing the backspace 
key (found in the upper r ight, appropriately renamed 
the delete key on the newer keyboards) wi ll backspace 

The 1-Beam 

I 

The Insertion 
Point 

The Important 
Basics of Typing 
on the Mac 

Backspace/ 
Delete 
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TYPING 

: over and remove any letters in its path. So you can 
. backspace/ delete to correct typos as you go, or set th e 
. insertion point down anywhere e lse in your text and 
· backspace/ delete from there. 

Highlighting Text Highlighting text is a shortcut to backspacing over 

40 

! 

· le tters to remove them. All through the Mac environ-
. ment, if you do uble-click with the 1-beam on a word, the 
: entire word is selected, indicated by the highlighting. 

This dl! is highlighted. 

· If you want to select more than o ne word, press-and-drag 
: over the entire area you wish to highlight. 

Part of this lin is highlighted. 

· What does highlighting do? Well, once a word is high­
. lighted (selected ), anything you type wi ll entirely replace 
: the highlighted text. Or you can now change the font 
. (typeface) or style or size of the text using your menu 
· commands. Or you can copy or cut or dele te that text. 
· Or you can paste something in to replace it. In fact, 
· you cannot do any of these things unless the text is first 
· highlighted. (Each of these procedures is explained in 

this chapter.) 

To unhighlight, click once anywhere, even in 
the black space. 

When to Use : Word wrap: In a word processor, you neverwant to hit 
the Return Key . the Return key at the end of your line , unless it is the end 

' . of the paragraph or unless you really do want the line to 
e · always end the re, as in an address. This is because word 

· processors have word wrajJ- the words just wr ap them-
. selves around onto the next line when they get to the 
. right margin. Why is that? Well. .. 

· Hard return: What happens when you press the Return 
: key is that you insert what is called a hard return. T hen if 
. you were to change your margins, your line would always 
· break at that hard return , even if there are only two 
· words on the line. So, just keep those nimble fingers 
· moving along and on ly hi t the Re turn key when you wam 
: a new paragraph. 



Double-space: Hitting the Return key twice is like 
pushing the carriage re turn on a typewriter twice- you 
get a double space between the Jines. This is for extra 
space between paragraphs (although in most word 
processors you can ask for an automatic increase of space 
between paragraphs). If you want the entire document, 
or even j ust a piece of it, double-spaced-that's different; 
there is always an instant way to change your spacing to 
double-spaced . Check your manual fo r the me thod for 
your particular application. 

Removing a return: T he computer sees a Return as just 
another character, which means to remove a return you 
simply backspace over it, just like to remove an unwanted 
character. T he problem is, in most programs you can 't 
see the Return character. So you must set the insertion 
point just to the left of the first characte r on the line and 
backspace/ dele te, like so: 

lhere set the insertion point to remove the empty line above 
this one. Backspace/ delete again to llffap the sentence back 
up to the one above. 

TYPING 

The computer deals with blank spaces just as it deals Blank Spaces 
with the characters you can see. Every tab, return , space-
bar space, e tc., is a character to Mac. T his means you can 
select blank spaces, blank lines, blank tabbed spaces, or 
returns in order to delete them. Select and delete them 
just like you would any o ther character. 

The space between 
these words is highlighted. 

In many applications 
you con also select the blank space 

between the lines to delete it. 

Also, since these blank spaces are characters, you can 
actually change the size of them (font size, that lis) , as 
well as the leading (space between the lines), the style, 
the paragraph spacing, etc. This comes in hanctY for 
manipulating space. 
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Centering Text : And a most important thing: when you center a word or 
' . line, Mac takes all those blank spaces into consideration , 
• . so any spacebar spaces or any first-line inden ts or any 

· tabs you 've inserted will be used to calculate the center 
· of the line, making the line not afJpear centered. 

This line appears not to be 

centered, althoughithasbeen Th is line is centered. 
selected and told to be cen_ter_e_d_. ----This line is also centered 

The lab space has been selected 
and will now be deleted. 

but it includes a tab. 

The invisible tab character 
that is disrupting the alignment 

must be highlighted 
and removed, like so: 

-This line is also centered. 
Then it will be centered just fine: 

----This line is also centered. After deleting the inuisib~ space, 
the line is now centered just fine. 

Changing Fonts 
(Typefaces} 

and 
Rule #2 

: Throughout the entire Mac environment, to make any 
. changes you must follow Rule #2: 

Select First, Then Operate. 

42 

· For instan ce, to change to a different font, or typeface: 
: first select the type you want to change (press-and-drag 
. over the word/ s), then choose the font name you want to 
. change it into. The font list is found in your menu under 
· various labels, depending on your program. 

' otice that the insertion point picks up whatever 
• font and style and size and a lignment is di1·ectly to 

the left of it. No matter where you set it down, you 
will type in the font, e tc, of that character, even 
if that character is an empty space (unless you 
proceed as in the follO\ving paragraph). 

: Now, let's say you know that the next thing you ' re going 
to type is going to be in a different font. Do you need to 
type it first and then select it and change the font? No. 
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Set your insertion point down where you want to type in ' 
the new font. While nothing is selected, go up to the menu • 
and choose th e font (and style and size, if you like ); when 
the re is no text selected , all the fo rmatting gets poured into 
the insertion point-whateve r you type next will be in the 
fon t you just chose. As soon as you place the insertio n 
point e lsewhere, though, it will again pick up all the 
formatting of the character to its left. 

Please see Chapter 13 for more information on fonts. 

Style is refe rring to whe the r the type is plain , bold, italic, : Changing Style 
outline, etc. T o change the style of the type, you need to 
follow Rule #2: select first, then operate. Select the type to be 
changed (hig hlight it), tl1en choose the style you want 
from the menu. Yo u can choose more than one of these; 
for instan ce, you can have a face tha t is bold-ita lic-
outlined-shadowed type. Yuk. 

To remove all of the style cho ices at once, simply ' 
select tl1e text and choose Pla in or ormal. • 

As mentioned in that last sectio n about changing f onts, 
you can choose th e style you want fro m the menu before 
you type it (as long as you don ' t move ilie insertion point 
afte r choosing). But even that's a pain if you just want to 
italicize the next word and then return to normal text. 
This is the preferred method: 

Notice ilie keyboard shortcuts in the style menu? They 
are almost always Command-B for Bold, Command- 1 for 
Ita lic, e tc. (Some programs may use Command-Shift-S 
and Command-Shift-1, e tc.). 

Changing Styles 
. Mid-Stream-

As you 're typing a long, simply press Co mmand-B 
and the next word you type will be bold; when 
you want the next wo rd to be not bold, press 
Command-B again and it will take of! the bold 
(tha t's called a toggle switch, when choosing 
ilie same command turns that command oil). 
Logically, you can press Command-Pt-1 to create 
a wo rd that is (guess!) bold italic. 

. Without Using 
·the Menu 

' • 

Size in type is measured in points. Points, in the tradi- : Changing 
tiona! type world outside of pe rsonal computers, are each . Type Size 
Yi2 of an inch . The Macintosh d eve lopers were bri lliant 
in designing the Mac screen so each pixel, or do t o n the 
screen, is Y12 of an inch-type sizes a re quite true to wha t 
those who deal wi th tradi tiona l type are accusto med to. 
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Alignment 

. In your menu you see different numbers referring to the 

. size of type; logically, the bigger the number·, the bigger 

. the type. Again, to change the size: select first, then operate. 
· Or set your insertion point down and choose the size 
· from the menu before you type (see the last two sections 
: on changing fonts and styles) . For more informatio n o n 
. type sizes, see the next chapter on fonLs. 

· Alignment refe rs to where the margins are lined up: 
: align left has the left margin lined up; align 1ight has the 
. right, obviously; align center has everythi ng centered on 
· a vertical axis between your margins; justified has both the 

left and right margins lined up. To change your align-
. ment, you know what to do! T hat's right: selectfirst, then 
: ojJerate-highlight the text, then choose the a lignment. 

· A note when cen tering: If you have a fi rst-line indent 
: or tabs in the text that is to be centered, or if you have 
. inserted blank spaces either before or after the text, then 
· those spaces are taken into consideration when center-
. ing; Mac sees them as characters. So if your centered text 
· doesn' t look centered, select and remove any extra space 
: (see page 42). 

Cut, Copy,· Almost anywhere you can type, you can cut or copy tex t. 
and the : When you cut text, it is removed from your document 

Clipboard . and placed on th e Clipboard. When you copy text, the 
. original is left on yoU1· document and a cojJy of it is placed 
· on th e clipboard. Well, what the heck is the Cli pboard? 

. The Clipboard: The Clipboard is a li ttle "container" 
· somewhere in the depths of the Mac. In some programs 
· you can ask to Show the Clipboard, in which case it appears 
: as a window with its contents displayed. In most pro-
. grams, though, you never see it; you j ust must trust that 
. it's there. (If you have the Clipboard system icon in your 
· System Folder, then it's there in every application.) 

. T he Cli pboard holds whatever you have cut or copied, be 
· it text, spreadsheet data, graphics, e tc. Once something 
· is on the Clipboard, it waits there unti l you paste it in 
· somewhere (you' ll get to that in the next paragraph). 
: The most important thing to remember about the 
. Clipboard is that it holds only one thing at a time; that is, 
. as soon as you cut or copy something else, whatever was 



in the Clipboard to begin with is replaced with the new 
selection. 

The ClifJboard 

appears as a 
window (if it's 

available f or 
looking at) 

~D~ Clipboard ~0~ 

The Clipboard 
holds only one item 
at a time. 

Items will stay o n the Clipboard even when you change 
applications; you can put something on the Clipboard 
in a paint program, then open up a word processing 
program and paste it into a new d ocument. Items will 
leave the Clipboard all by themselves if the computer is 
turned off or if there is a power failure; the conten ts are 
stored in RAM, so anytime RAM ge ts wiped out, so do 
the conten ts of the Clipboard. (RAM info on page 63). 

How to Cut: Simply select, then operate; that is, select · Cut 
the text you wish to remove from the documen t (press­
and-drag over it). Then from the Edit menu choose 
"Cut. " It will be eliminated from your document and 
placed on the Clipboard. (Be sure to read "Delete" 
furth er o n in this section.) 

How to Copy: Simply select, then operate; tha t is, select · Copy 
the text you wish to copy (press-and-drag over it) , then 
from the Edit menu choose "Copy." It will remain on your 
document and a copy will be placed on the Clipboard. 

OK-it's on th e Clipboard. Now wha t? Well, the Paste 
Clipboard holds it for pasting. You can take text or 
graphics ou t of one place and paste it into your docu-
ment somewhere else, just as if you had a little glue pot. 

How to Paste: Wi th text, simply set the insertion point 
down where you want the Clipboard item to appear; 
from the Edit menu choose "Paste ." Whatever was on the 
Clipboard will be inserted in your document beginning at 
the flashing inse1tion point. Spreadsheet data, graphics, 
e tc., all can be pasted in also. 

As long as something is on the Clipboard, you can paste 
it in a million times. 

TYPING 
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Backspace/ 
Delete 

or Clear 
and the 

Clipboard 

Now, Backspace or Delete is a little different: ifyou 
hit this key (upper right of keyboard) while something 
is selected, whatever is selected is deleted and is not p laced 
on the Clipboard. This means it won't replace what you 
have on the Clipboard, if you are saving something there 
to paste in again, but it also means that you don ' t have 
it anymore-it is really gone. Clear, sometimes found in 
the Edit menu, does the same thing. 

Undo : Undo can sometimes save your boompah (no, that's not 
. computer jargon-it's Grandma's euph emism). 'Vhen 
· you do something that makes you scream, '1\ack! Oh no! " 

then try Undo. It's always in the Edit menu at the top of 
the list (or use Command-Z). 

' What Undo can undo is only the last action that 
• occurred. For instance, if you selected two para­

graphs of brilliantly witty text that you spent 
three hours composing and just then the cat 
walked across your keyboard and obliterated the 
entire work, Undo could give it back to you IF 
you asked to Undo before you touched anything. 
If you start fiddling around with the keys and the 
mouse, then wh at you will undo is that fiddling 
around. So if something goes wrong, the first 
thing to do is UNDO. 

Command-Z XC V · Thoughtfully, the Mac designers have made the key-

46 

. board sh ortcuts for the cut/copy/ paste/undo commands 
· very handy. Notice on your keyboard the le tters Z, X, C, 
: and V, all in a row right near the Command key. 

• Command-Z will Undo (the closest to the~ key). 

• Command-X will Cut (X like eXiting or Xing it out). 

• Command-( will Copy (C for Copy, easy mnemonic). 

• Command-V will Paste (V because it is next to C). 

· It's nice to get familiar with these. Remember, select first 
· (except to Undo); then hold down the Command key while 
: pressing the other letter. 

Accessing · Special characters are the symbols you have access to 
Special : on the Macintosh that aren ' t avai lable on a typewriter, 

Characters . such as upside-down question marks for Span ish (~), the 
. pound symbol for English money(£) , the cents sign (¢), 

the registra tion or trademark symbols (® TM ), etc. You 



can view all these with your Key Caps desk accesso ry. 
(If you aren ' t sure what Key Caps is, please read page 82.) 

To get special characters into your document, follow 
these steps: 

• While working in your document, pull down the 
desk accessory Key Caps from the Apple menu 
(far left; press on the apple). 

• From the Key Caps menu (a new item that appears 
now on the right!) choose the font you wish to view. 

• Find the character you want by pressing Shift or 
Option or Shift-Option together; press the character 
key; notice what combination of keystrokes produces 
the character you want. For instance, Shift-Option- .... 
(tilde key) in the font Geneva will produce a bunny 
rabbit: ,.._ 

• So remember that keystroke combination; close up 
Key Caps to get back to your document (remember, 
you can access desk accessories in any program). 

• In your document, set your insertion point down; 
choose the font Geneva and the size 12 po int; press 
Shift-Option- ..... The bunny will appear ! 

Another way to accomplish this is to press Shift-Option-"" 
in whatever font you are currently using; some strange 
char acter will appear. Select the strange character and 
change it into Geneva 12 point; it will turn into a bunny. 

You can also select and copy the character showing in 
the Key Caps entry bar-select as you would any text, 
and copy from the Edit menu. Back at your document, 
set the insertion point and paste it in . Unfortunately, 
if your document text is another font, the Key Caps 
characters will p ick up that fon t. You will still have to 
select the new characters and change them into the font 
that held those characters you wanted. It seems easier 
just to do it the other way. 
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Using Key Caps 

Some special characters 
and the keys to 
access them: 
• Option-S 

© Option·g 
™ Option·2 
® Option -r 
¢ Option- $ 

Option - Shih · 8 
Option-; 
Option -hyphen 
Option · Shih - hyphen 

. Just ForFun- using 
Shift-Option-Tilde ( -) 

¥ New Yor k 9 pt. 

" New York ! Opt . 

t New York 12 pt. 

:n New York 14 pt. 

0 Geneva 9 pt. 

~ Geneva I 0 pt. ,... Geneva 1 2 pt. 

Monaco ... 9 pt . 

0 Monaco 14 pt. .. ~ 

R thens I 'i pt. •.: 

Remember, the insertion point picks up the ' 
f ormatting of any character immediately to its left, even • 
if it 's a blanh sjJace, so anything else you type will 
be in that character's fon t, style, etc. To continue 
in your original font, leave your insertion point 
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Using 
Accent Marks 

' • 
A list of common . 

accent marks: . 

1\ 

Option- e 

Option - ­

Option - u 

Option- n 

Option- i 

One Space 
After Periods 

A Commercial 

right where it is; from the menu just choose the 
font specifications you were originally using. 

Included in your special characters are accent marks, 
such as those in resume and pinata. You can find them 
in Key Caps, but it's easy to remember that they' re 
accessed using the Option key and are hiding beneath 
the characters on the keyboard that would usually be 
under them; e.g. the accent acute over thee is Option-e; 
the tilde over the n is Option-n. 

To type accent marks in your document, follow these 
steps (using the word resume): 

• Type the word until you come to the letter that will 
be under the accent mark; e.g. r 

• Befo-re you type that le tter (the letter e in this case), 
type the Option combination (Option-e in this 
case) - it will look like nothing happened. 

• Now type the character that is to be under the accent 
mark, and both the mark and the le tter will appear 
together; e.g. r e s u m e 

• That's easy, huh! 

What?! One space after a period? If you grew up on 
a typewriter, this is not an easy habit to change. But 
characters on a Macintosh are not monospaced as they 
are on a typewriter (except for Monaco and Courier), 
so there is no longer the need to use two spaces to 
separate two sentences. Take a look at the font Courier 
on page 56; notice the spacing of its letters as opposed 
to the Times fon t above it. You can see why a font like 
that needs two spaces after periods. Check any book or 
magazine on your shelf; you will never find two spaces 
after periods (except books produced on a computer 
typed by someon e still using typewriter rules) . 

If you are typing on a Macintosh, you must face the fact that it 
is not a typewriter and that some of the standard conventions 
developed particularly for that wonderful little appliance do not 
apply to the kind of type you are now creating. A very important 
book to read is The Mac is not a typewriter fly the same 
author and publisher as this book. It 's small, it 's cheap, it's easy 
to read, and it 's true. 



In the Mac environment, the term fonts refers to the 
typefaces available . T echnically, that 's not exactly what 
it means traditionally, but we' lllet it pass rathe r than 
confuse the issue. 

Certain fon ts are standard with the System that comes 
with your Macintosh: 

Geneva 

New Yor k 

Monaco 

Chicago 

Venice 

Helvetica 

Times 

Courier 

Symbol (Greek & other charaCLcrs) 

The list is separated into two columns inten tionally­
do you notice anything funny about them? No? Well, 
it's this: one list is all city names; the other is not. Big 
deal, you say. 

Actually, it is a big deal. The Mac can print to basically 
three kinds of printers: the Image Writer , with a lower 
resolution of about 75 dots per inch; the laserwrite rs, 
with higher resolutions of 300 to 400 dots per inch; and 
the high-end machines such as the Linotronic, with very 
high resolutions of around 2000 dots per inch . The higher 
the resolution, the clearer and sharper the printed letters looh. 
What you are reading right now is from a Linotronic. 
Macintosh fon ts are either bit-mafJped---designed for low 
resolution , like the lmageWriter; or PostScript, designed 
for high resolution, like the LaserWrite r or Linotronic. 
T he city names clue you to which font works best with 
which type of printer. 

T he typefaces Helvetica and Times are very popular , 
standard typefaces in traditional type, which the Mac 
is emulating . Courier is monospaced and shaped like a 
typical typewriter font. T hese three, plus Greek Symbols, 
are installed in the Macintosh system, as well as in the 
LaserWriter, the prin ter with the higher resolution of 300 
dots per inch . T hey look very n ice when printed on the 
LaserWriter or any of the high-end printers. 

CHAPTER THIRTEEN 

Fonts 

: Interesting Font 
. Information 

Printers 

Traditional Fonts 
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Name Associations ow, what city do you associate with The T imes? 
ew York, you say? (Actually, Times was invented for 

. The London Times, but we' re in America, so . . . ) How 
right you are! New York is the bit-mafJped, JmageWriter 
version oJTimes. Times has been redesigned into New 
York to look as clean as possible for the lower resolu tion 
of the Macintosh screen (72 dots per inch) and for the 
Image Writer printer (approximately 75 dots per inch). 

This' ll stump you-what coun U)' is the typeface 
Helvetica named after? Wrong again, dear­
Confederatio Helvetia is what Switzerland calls herself. 
Do you see a font with a city-name associated wi th 
Switzerland? Of course: Geneva. Geneva is the bit-mapped 
Image Writer version of Helvetica. 

And for some reason as yet unfathomable, the bit­
mapped Image Writer version of Courier (which looks 
like a typewriter and why anyone would want to use a 
LaserWriter to make their work look like a typewriter 
is a mystery) is Monaco. 

Other Installed Fonts Other PostScri.fJt fonts are a lso installed into the Laser­
Writer, so if you have bought them and they are installed 
in your System you can use them without any trouble. 

so 

Pala tino 

Avant Garde 

Zapf CfiarrcenJ 

Bookman 

New Century Schoolbook 

Zapf Dingbats: .._ • ~ .. c;> 

(Zapf Chancery, by the way, was designed by a German, 
Hermann Zapf, but modeled on an old Italian calligra­
phy. Its ImageWriterversion is Venice, an Italian city. 
Zapf Dingbats: dingbats is a technical printe rs'/ 
typographers' term referring to those li ttle tiny pictures.) 

· The fonts th at don't come with your System are things 
· you have to buy; they come on a disk and must be 
: installed into your system with a Font/ DA Mover . 
. Apple provides a Font/ DA Mover on one of the disks 
. that arrived with your Mac (see Chapter 14 to learn how 
· to work with the Mover). 

Important . T hat's a lot of very interesting trivia, you say, but so what? 
Information Well, the important thing to remember about a ll th is is 

tl1e cardi nal rule: 
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Never use a typeface with a city name 
on the LaserWriter. 

What happens is the LaserWrite r can 't read bit-mapped Why Not? 

fonts, so it has to create them when you print. Many 
programs will automatically substitute Times for ew 
York, Helvetica for Geneva, and Courier for Monaco, 
fooling you into thinking you have the real LaserWriter 
font. Have you ever seen (or produced) work on a Laser-
Writer where the words had awkward gaps between 
them, the numbers didn ' t line up, the tabs didn 't line 
up, the shift-line was broken, or they looked almost as 
raggedy as on the screen? That's the result of printing 
city-named fonts on the LaserWriter. Examples: 

This is an example of 
9 pl. New York fr o m the 
LaserWriter w ith no 
font s ub stitution . 

This is an example of This is an example or 
9 pt. New York from the 9 pL. Times from the 
LaserWriter with auto- LaserWriter. It doesn't 
maLic font substitution. need font substi tution. 

The bit-mapped city-named fonts were designed (and 
actually look better than the others) for the lmageW1iter. 
So it's best to keep each one where they belong. 

The type size listings in the Mac also have a lit tle vagary 
that's nice to know about. Have you noticed how some 
of the sizes listed are in outline type, and some are not 
(see right)? This can be different for each font. 

What the outlined number is indicating is that this 
particular size for this particular font has been installed 
in the System. It will look its best on the screen in the 
outlined size, and will print best on the Image Writer 

Installed sizes 

in the outlined size. You can ask for any other size, and 
in some programs type in your own size up to 127 point 
or beyond , but it'll look funky. T he bigger, the funkier. 
And if it looks funky on the screen , it will look funky 
on the Image Wri ter, because the ImageWriter can only 
reproduce what it sees on the screen. 

The LaserWriter, o n the other hand, can create a 
PostScript font (not a city name) in any size you like. So 
even if it looks totally gross on the screen, the Laser­
Writer will prin t it as neatly at 95 point as it wi ll at 12 
point (as, of course, will any PostScript machine). Note 
the example o n the next page. 

51 



fONTS 

57 point Times 
on the screen and 

jJTinted on the 
hnageW1ita R R 

57 point Times 
printed on the 
Las a Writer 

If you acquire more screen sizes (or entire foms, for that 
matter), yo u can install them with your Font/ DA Mover 
(see Chapter 14). 

Screen fonts 
and Printer fonts 

Bit-mapped fonts, which are those fonts designed for 
the Image Writer and which usually have a city name, 
have only one part to them-the screen font itself. Since 
the Image Writer prints what it sees on th e screen, the 
screen font contains all the necessary information. Once 
the screen font is installed in the System (it will show up 

en 
Fonts 

Icon that holds 
screen fonts . 

in your font list), you' re ready to type and print with it. 

PostScript fonts, however (those designed for printers 
such as the LaserWriter) , have two separate parts- a 
screen font and a corresponding printer font. When you 
acquire new PostScript fon ts, you must install the screen 

: font with the Font/ DA mover,just as with bit-mapped 

N~wBasRom 
fonts; you must also put the printer font icon into the 

Icon representing · System Folder. P1inter font icons cannot be inside any 
a jJrinterfont · other folder inside the System Folder or the printer 

(lTC New Baskerville Roman) won' t be able to find them. 
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The PostScript LaserWriter fonts listed in this chapter 
have the ir printer fonts installed directly in to the 
LaserWriter 's read-only memory, so you needn ' t worry 
about their printer icons. 

More Examples On the following pages are examples of the fonts that 
are supplied \Vith your System, and also the othe r fonts 
that are installed in the LaserWriter. 

(Notice the ajJostrophes printed in these examples! See page 88 
if you are interested-which you should be-in how to tytJe 
ajJostrophes and quotation marks.) 



FoNTS 

lmageWriter fonts on the lmageWriter; Faster Quality; Tall Adjusted 

Geneva ( 1 0 poi nt) 

Pl ai n: The quick brO\o/n fox jumps over the laztJ dog's back. 
Bold: The quick brovn fox jumps over the lazy dog"'s bock _ 
ltBlic: Ttte quid.' broJ .. 'Il Ia\' jumps Ol·1!i'r t,te l&.y tfo? ·s bBck. 
Bill /Ia/: The quick brDtr"ll Fox _jumps Dt-"flr the /.azg dog~ IJIJck_ 

New York (10 point) 

Plain: The quick brown fox jumps over the lazy dog 's back . 
Bol<l: The quick brovn fox jumps over the lazy <log_ 
lts.lic-: l'l1e quick to.ro1Fn lox jumps OT·"er the l&,V dog :"r back 
Bid Ita/: The quick l>roFEI foz jumps over the lazy dog. 

Monaco (9 point> 

Plain : The quick brown fox jumps: over the lazy dog's back . 
Bo I d: The qu i ck bro•n fox j u•ps over the I azy dog_ 
I t a lic: The qui cl<: br{J-wr1 fox jumps O(,~r the lazy ckJq 's back . 
Bdltai:The quick bro.n rox .fu.ps over the lazy dog. 

Chicago 41 0 point) 

Plain: The quick brown foH juml]s ot•er the lezy !Jog's back. 
Bold : The quick •r-o•n feH j•mps o•e.- the la;zw deg . 
ltslic: 7/Je quir.l: brown loa _jump Uiler lite IHcg dog}$ becl'. 
1111 IIIII: Tke llllk-k briNIII fBM../fiJ11116 ttoer Ike lflZIIIIOI, 

lktt.i.ce ( 10 poi..ttt) 

Plo.i.n~ 'Jhz qu~ ilt"own fmc. ;utnps DtJI!l-t" tfu: Cozy docj•s btu:ft._ 
aal4= '7ft& .._....-.. t.«"own. 1 '"'- ju.1Rfl!!t a~ t&e Ca:z.J ~ _ 
zm&.. 71u: qitid ~~ fwc:_i$ntlpS tJ'tl£r /hr. fazy dCI!I ~ lia&._ 

1tF4 UtA~ Vie~ 61TUC',. fox .fDnsps 011'£r toiW l4zzy ~-
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lmageWriter fonts on the LaserWriter • no font substitution 
{The lines are drawn in, as opposed to using the underline function) 

Geneva (1 o point) 

Plain: 
Bold: 
Italic: 
Bid /tal: 

The quick brown fox jumps over the lazy dog's back. 
The quick brown fox jumps over the lazy dog's back. 
The quick brown fox jumps over the lazy dog's back. 
The quick brown fox jumps over the lazy dog's back. 

New York (10 point) 

Plain: The quick brown fox jumps over the lazy dog's back. 
Bold: The quick brown fox jumps over the lazy dog. 
!Lalic: The quick brown f ox jumps over Lhe lazy dog's back. 
Bld /tal: The quick brown fox jumps over the lazy dog. 

Monaco (9 point) 

Plain: 
Bold: 

The quick brown fox jumps over the lazy dog's back. 
The quIck brown fox jumps over the I azy dog 

Italic: The quick brown fox jumps over the lazy dog's back. 
Bdltai:The quick brown fox jumps over the lazy dog. 

Chicago (1 0 point) 

Plain: 
Bold: 
Italic: 
Bid I tal: 

The quick brown foH jumps ouer the lazy dog's back. 
The quick brown foH jumps ouer the lazy dog. 
The quick brown foH jumps ouer the lazy dog's back. 
The quick brown foH jumps ouer the lazy dog. 

Venice (10 point) 

Pl:a.in: The qu.i.cR. brown fox jumps over the l:a.zy d01;;J's bacR.. 
:Botd: The. qu.i.c~ brown fox ju.l'nps ove.r the. tc::a.zy do9. 
"ltaUc: The quick brown fox jumps over the £azy clog's back. 
Bla 'ttal: The quick brown fox jumps over the lazy clolJ. 
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lmageWriter fonts on the LaserWriter • automatic font substitution 
(The lines were created using the underline function; notice how awful they look, crowding the words. 

Also notice the awkward word spacing} 

Geneva (1 0 point) 
Plain: The quick brown fox jumps over the lazy dog's back. 
Bold: The quick brown fox jumps over the lazy dog's back. 
Italic : The quick brown fox jumps over the lazy dog's back. 
Bid Ita/: The quick brown fox jumps over the lazy dog's back. 

New 
Plain : 
Bold: 

York CIO point) 
The quick brown fox jumps over 
The quick brown fox jumps 

Italic : The quick brown fox jumps over 
Bid /tal: The quick browTZ fox jumps 

Monaco 19 point\ 

the lazy dog 's back. 
over the lazy dog. 
the lazy dog's back. 
over the lazy dog. 

Plain: The quick brown fox jumps ove r the lazy dog' s back . 
Bold : The quick brown fox jumps over the lazy dog . 
Itali c : The quick brown fox jumps over the lazy dog' s back. 
Bdital: The quick brown fox jumps over the lazy dog. 

Chicago ( 10 pojntl 
Plain: The quick brown foH jumps ouer the lazy dog's baclc. 
Bold: The quiclc brown foH jumps ouer the lozy dog. 
Italic: The quick brown foH jumps over the lazy dog's back. 
Bid /tal: The quick brown foH jumps over the lazy dog. 

Venice ( 10 point) 
:Pt:ain: ~qui&~ brown fox jumps over the t:azy cio9 's bac~. 
13ot<!: 'The quic~ brown fox ;u.mps over the l:azy do9. 
Ua!ic: 1he quick brown fox jumps over the !azy c!og 's back. 
Jj[fi Ual: The qu£ck brown fox jumps over the !azfj tlolJ. 
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LaserWriter fonts on the LaserWriter • no font substitution 
(The lines ore drown in, os opposed to using the underline function) 

Helvetica (12 point) 

Plain: The quick brown fox jumps over the lazy dog's back. 
Bold: The quick brown fox jumps over the lazy dog's back. 
Italic: The quick brown fox jumps over the lazy dog's back. 
Bold Ita/: The quick brown fox jumps over the lazy dog's back. 

Times (12 point) 

Plain: 
Bold: 
Italic : 

Bold /tal: 

The quick brown fox jumps over the lazy dog 's back. 

The quick brown fox jumps over the lazy dog's back. 
The quick brownfox jumps over the lazy dog's back. 

The quick brown fox jumps over the lazy dog's back. 

Courier (12 point ) 

Plain : The brown fox jumps over t he lazy dog . 
Bold: The brown f ox jumps over the lazy dog . 
Italic : The brown fox jumps over t he lazy dog . 
Bld Itl: The brown fox jumps over the lazy dog. 

Symbol (12 point) 

Plain: T11t: emxK ~powv <j>o~ q>UJ..lncr omt:p TllE A.as'l'8oyilcr ~axK. 
Bold: T11E SutXK ~powv <j>o~ q>UJ..lncr omt:p TllE A.as'l'8oyilcr ~axK. 

Italic: T71£ 9vtXK {3powv ¢o~ cpVJ.L7UJ oUJcp 'rTJc A.a(1f18oyJl<J f3axK. 
Bold Ita/: T71£ evtXK {3powv ¢o~ cpvJ.Ln<J oUJcp 'rTJc A.a(1f18oyiJ<J f3ax1c 

Palatino (12 point) 

Plain: The quick brown fox jumps over the lazy dog's back. 
Bold: The quick brown fox jumps over the lazy dog's back. 
Italic: The quick brown fox jumps over the lazy dog's back. 
Bold Ital: The quick brown fox jumps over the lazy dog's back. 
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More LaserWriter fonts on the LaserWriter 

Avant Garde (1 2 point) 

Plain: 
Bold: 
Italic: 
Bid /tal: 

The quick brown fox jumps over the lazy dog's back. 
The quick brown fox jumps over the lazy dog's back. 
The quick brown fox jumps over the lazy dog 's back. 
The quick brown fox jumps over the lazy dog's back. 

Bookman (12 point) 

Plain: The quick brown fox jumps over the lazy dog's back. 
Bold: The brown fox jumps over the lazy dog's back. 
Italic: The quick brownjoxjumps over the lazy dog's back. 
Bld Ital:The brownfoxjumps over the lazy dog's back. 

New Century Schoolbook (12 point) 

Plain: The quick brown fox jumps over the lazy dog's back. 
Bold: The quick brown fox .jumps over the lazy dog. 
Italic: The quick brown fox jumps over the lazy dog's back. 
Bld I tal: The quick brown fox jumps over the lazy dog. 

Zapf Cfiancery (12 point} 
No, this isn' t 

PCain: 

'BoU: 
Itafic: 

'BU Itaf: 

'IIie quicl(_6rown fol(jumps over tlie {azy dogs 6ac~ 
'IIie quicl(_6rown fol(jumps over tfie {azy dogs 6ac~ 
'IIie quicl(_6rown fol(jumps over tfie [azy dogs 6ac~ 
'I1ie quicl(_6rown fol(jumps over tfie {azy dogs 6ac~ 

a typographic 
error: Zapf 
Chancery is small 
for its size, and 
doesn't change 
styles. 

Zapf Dingbats (12 point) 

Plain: * * * D+*** coot• *DI ~*+ODA O•!•* D Te 
CAPS: **+ **'ti+* +**** +** O**i'r* **+* **+ 
Italic: *** o•*** 0001• *01 ~:~•oo~ O·:·•o ,.. 
Ou tline: *** !JJO*** 001QJDO ®QJI * 0 0016 Ql~$01 'VO 
See lhe Zapf Dingbats chart on page I 03. 
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FONTS 

Font Sizes Below are two of the PostScript fonts shown in several 
sizes to give you an indication of what to expect in a 
particular size. T hey have been prin ted on a Linotronic. 
Times is a se~if; Helvetica is a sans serif (This book is set 
in 10 point ITC ew Baskerville, with heads in 10 point 
Fu tura Bold.) 

This line is sel in 6 point Times. 

This line is set in 8 point Times. 

This line is set in 9 point Times. 

This line is set in 10 point Times. 

This line is set in 12 point Times. 

This line is set in 14 point Times. 

This line is set in 18 point Times. 

This line is set in 24 point Times. 

This line is 30 point Times. 

This line is set in 36 pt. 
This line Is set in 6 point Helvetica. 

This line is set in 8 point Helvetica. 

This line is set in 9 point Helvetica. 

This line is set in 1 0 point Helvetica. 

This line is set in 12 point Helvetica. 

This line is set in 14 point Helvetica. 

This line is set in 18 point Helvetica. 

This line is 24 point Helvetica. 

This line is 30 pt. Helvetica 

This line is set in 36 pt. 
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FONT/DA 
MovER 

A font is a typeface. DA stands for desk accessory, 
the items under the Apple menu o n the far left (see 
Chapter 20 for more info o n DAs). To move fonts or 
desk accessories from one place to another, like from 
a suitcase icon to your System, or from the System on 
your hard disk to a System on a floppy, you need to 
use the Font/ DA Mover. You also use this tool to remove 
them from a System. 

When you buy your Mac, a Font/ DA Mover is supplied 
on one of the disks. Typically it's stored in the System 
Folder or Uti li ties Folde r, but it can be kept anywhere 
you like, even on a separate floppy for occasional use. 

Where do you find the fonts to put in? Well, you 'll 
notice in your System or Utilities Folder you have a 
little suitcase icon with a big lette r A on it (you should 
have one, anyway-it may be in another folder or on 
one of your original disks). This icon represen ts the 
con tainer for your screen fonts; if you double-click o n 
it you will get the same dialog box as if you opened the 
Font/ DA Mover. 

Fon ts also reside in your System, after they have been 
installed. A few are installed at the factory, and if you 
bought other fonts at the same time as buying your 
computer, the shop may install them for you. 

To install or remove fonts or DAs, find the Font/ DA 
Mover icon (as shown at the top of the right-hand 
column ) and double-click o n it. You will see the dialog 
box shown on the fo llowing page. 

CHAPTER fOURTEEN 

Font/DA Mover 

w 
F on tiD A Mover 

. Where Fonts 
Reside 

en 
Fonts 

Using the 
Font/DA Mover 
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FoNT /DA MoVER 

he/her you're This indicates w 
looking at fi onts or DAs. · @Font 

Mouer 

60 

0 Desk Accessory 

Boston 10 

' 
( [Of)l_l 1 fQ 

: I I 

Chicago 12 ( Remoue 1 ur font list is Courier 12 Yo 
prob ably different. · Geneua 9 I 

lis you where 
· I of fonts or 
s are located. 

This le 
this l!s 

DA 

Geneua 10 3846 bytes 
Geneua 12 0 selected lQ 

System 

! on Hard Disk ( Help 1 
917K free I 

( l i ( l l Open ... j Close i Quit 
···········-···················-····································-····································-····················· ········-·-···········-·· 

Boston 12: The quick brown fox jumps over the 

Font/DA Mover dialog box Click on the Click this 
name of a button to 
font to show find another 
a sample file with fonts 
0 if it here. in it. 

What the Font/ DA Mover automatically opens up to 
show you are the fo n ts that are installed on the System 

: that is booting (running) the machine or in the font fi le 
. you just opened-you see these listed in the left-hand 

box. Notice the sizes listed? T hose are the ones that will 
show up in your applications as the outlined numbers, 
the sizes that are installed (as noted on page 51). 

On the right-hand side is an empty box above a button 
labeled "Open." T his is waiting for you to open another 
font fi le so you can tra nsfer them back and forth. So ... 
click on that button to get this dialog box: 

Ill .. 



I [g) Utilities I 
D Fonts :B 
D System Folder 
D Update Folder 

The open dialog box within the Font/DA Mover 

[g) Utilities 

Eject 

Driue 

Open 

New 

Cancel 

From this dialog box you can find the file that contains 
the other fonts (Note: T he file you want may be the System 
o n another disk, or the suitcase file named Fonts, as 
shown above, or perhaps it is called Screen Fonts) : 

• If the fi le is on a disk in anothe r drive, click Drive 
to see it. 

• If the file is o n anothe r disk and the current disk 
must be ejected to put that one in, click Eject and 
stick the other one in. 

• "\o\'hen the fi le is visible in this box, select it by 
clicking once on the name; click Open ; or simp ly 
double-click on the name to open it. 

As soon as you open an appropriate fi le, you get back to 
the original dialog box (as shown o n the previous page); 
this time the right-hand box will have all the fonts from 
the fi le you j ust chose. 

At this point you simply select the fon ts from either side 
that you want to copy or remove (select them by clicking 
o nce on them), then choose "Copy" or "Remove." You 
can use shift-clicking he re to select more than one font 
at a time to copy-hold the Shift key down while clicking 
on or dragging over a ll your choices; they can all be 
copied or removed simultaneously. 

FoNr/DA MovER 
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FoNT /DA MoVER 

Copying or 
Removing 

Desk Accessories 

Macintosh desk accessories are also stored in a little 
suitcase icon or in the System. Accessories you buy 
from an outside source often have their own icon. 
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: Copying or removing desk accessories works exactly 
the same as with fon ts; just be sure to click the button at 

Desk Accessories · the top of the Font/ DA Mover dialog box to select DAs 
instead of Fonts. 

A Note About : Macintosh uses some of the typographic terminology in 
a sligh tly different way than traditionally, particularly in 
the way it defines "font." As an example (which is consis­
tent with the other Macintosh fonts), one of your fonts is 
named Times. Times is actually a generic family name; in 

Families,. 
Fonts, · 

and Styles · 

A Note About 
Downloadable 

Fonts 

the Times family you have regular, italic, bold, and bold 
italic; technically, each one of these members of the fami ly 
is a separate fon t each with its own separate group of 
characters. In the Macintosh environment, when you are 

· working with the typefaces installed in th e LaserWrite r, 
. the family name, such as Times, is considered the font 

name; the variations such as bold or italic are considered 
styles. It is important to know, though, that this is a 
Macintosh convention , because .. . 

· When you buy fonts that are not installed in the LaserWriter 
(any font without a city name othe r than the ones Jjsted 
in the Font chapter), you often cannot change the style 
from th e menu; these othe r typefaces follow standard 
convention and each different style is considered a separate 

· font and must be treated as such. For example, if you are 
using Futura and want to italicize a word, you must 
choose the f ont Futura Italic from the fon t list- you 
cannot simply choose "italic" from the Format or Style 
menu. Now, this is no t always true- font technology is 

· changing so rapidly and the standards are not defined 
· yet and everybody is fighting everybody else for supreme 
· font power. If you will be using typefaces o ther than the 
· standard installed ones, be sure to read about and under­
. stand them-they are usually termed downloadable fonts, 

as they must be downloaded into the LaserWriter in 
order to use them. There are several books available 
that deal just with the topic of fonts and how to install , 
download, and use them. 



Saving is the process of transferring your document 
from the temporary memory storage it is initally stored 
in to the floppy disk or hard d isk where it becomes 
permanent It is extremely important to save your 
document as soon as you begin working on it, and to 
continue to update the save every Jew minutes. 

Until you actually go through the process of naming a 
document and saving it, the document is stored in RAM, 
which is Random Access Memory. This is sort of like 
your desk: in the fi ling cabinet (comparable to your disk) 
you have all your folders of information. But when you 
are working on a project, you don't keep running back 
to the filing cabinet every time you need a little piece of 
informatio n , do you? No, you take out all the applicable 
info and put it on your desk, then when you're finished 
you put it all away again and take out something else. 
RAM is sort of like that: when you open an application 
tl1e computer puts a copy of that application into RAM. 
When you close that application and open another one, 
Mac puts the first one back where it came from and puts 
the new one into RAM. That way it doesn't have to keep 
going into the fi ling cabinet to do its work and it can 
operate much more efficiently. 

When you create a document, it sits in RAM, too, until 
you put it in the filing cabinet-your disk. You put it on 
your disk by saving it. Once it's on your disk, e ither 
hard or floppy, it will stay there unti l you trash it yourself. 

While your document is in RAM, though, it is in danger. 
At any moment, if there is a power fai lure, even for a 
split second , or you accidentally hit the wrong button, or 
you have a system crash , or ilie screen freezes, or a virus 
attacks, or any other catastrophe of considerable dimen­
sion happens to befall, then everyiliing in RA1\1 (what is 
commonly called memory}, is gone. Just p lain gone. No 
way on earth for a mortal person to get it back. 

The prevention? 505: Save Often, Stupid. Well that's a 
little harsh- how about Save Often, Smartie. Save Save 
Save. Every few minutes, when you're just sitting there 
thinking about your next marvelous move, Save. In most 

CHAPTER FIFTEEN 

Saving 

RAM: 
Random Access 
Memory 

Danger! 

Rule #1: 
Save Often! 
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SAVING 

Save As ... 
vs. Save 

Save As ... 

programs it's as easy as pressing Command-S. Then 
if the re is a catastrophe, you will have lost only the last 
few minutes of your work. 

To ini tally save a document, it must be given a name. 
Under the File menu are the commands Save As ••. 
and Save. At first the subtle difference can be confusing. 

Save As ... is the command you must use first in order 
to give the document a name, as a document cannot be 
saved withou t a name; "Save As ... " gives you a dialog bax 
such as the one shown below (they're slightly different 
from program to program). 

' e This shows which 
This is a list of all the . folder you are saving 

Unless the icon on this label is a disk, 
pressing here with the mouse shows a 
mini-menu listing the folders and the 
disk it is nested into. Select another folders and documents in . your document into. 

the folder or disk named . (Notice the folder icon.) 
I 

just as you use your menu. 

above. Folder names are · rr=====~=~t==~=========, 
black because you can j6l HC Book J 

double-click to ofJen them 
and store .mmething inside. 
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This is where you 
name the document. · 

Once you name the 
document, the Save 
button turns black 

and you can click it. · 

D Chapters 
D [!(~~ii.JnS1 <HI< 
D HC Ou11ine 
D Letters 
D Nott~s 1o rrH~ 

Saue document as 

I 
( Cancel ] 

This shows to 
which disk you 
are savmg the 
document. 

CJHard Disk: II 
[ [j(~d ] --­

If it's a floppy 
Brill(~ J you can then 

'------t--' eject that disk 

@ SuperPaint 

Startup Screen 

0 MacPaint 

Q PICT 

to switch to 
another before 
saving onto it. 

Many programs allow ) 'OU to 
save your document in one of 
several different fonnats. Click 
one before you click Save. 

II 

If you want 
to save to a 
different disk, 
other than the 
one whose 
name appears, 

clic/1 Drive to show you any disks that may be in the 
other drive slots. The name and icon will appear in 
the dialog box, as well as at the top of tl1.e scroll box. 



Save is what you use after it has been named and you 
want to save the new changes onto that document. Save 
just goes ahead and does it-you won't see or hear 
anything. You mustjust trust. 

There is no keyboard shortcut listed in the 
menu for "Save as .... " But if you have not yet 
given the document a name, then choosing Save 
(keyboard shortcut 3€-S) will give you the Save 
As ... dialog box because it must have a name. 
Some programs will not even a llow the name 
"Untitled ." 

If you want to create changes in a document, but want 
to keep a copy of the original without the changes, then 
use Save As ... a second time to give the document a new 
name. This puts the original docume nt safely away on 
your disk and opens a new one (the copy) right where 
you are. You ' ll notice the name in the window title bar 
of your document will change to what you renamed it. 
Any changes you make to this document wi.ll not affect 
the original. 

Also, if you made a bunch of changes you don't want, 
simply close the document and don't save the changes. 
Reopen it and everything will be exactly the way it was 
last time you saved. 

Occasionally a program will have the option to Revert in 
the File menu; this will revert you back to the last version 
you saved without having to close the current fi le . 

SAVING 

Save 

! 

:. Making 
Several Versions 

' • 

Reverting to the 
Last-Saved 
Version 

! 
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CHAPTER SIXTEEN 

Printing is the process of copying your data from inside Printing 
the Macintosh onto a piece of paper; this piece of paper, 
then, in computer jargon, is called "hard copy." 

The lmageWriter printer is the one people typically Printers 
have at home because it isn't very expensive (relatively 
speaking, anyway). It's a dot-matrix printer (75 dots per 
inch), but it looks much better than most of the dot-
matrix printers we've all seen over the years. On page 53 
is an example of the Image Writer quality using the fonts 
installed in the Mac. 

The LaserWriter is the printer that made desktop 
publishing happen. It takes the same document that was 
printed o n the Image Writer and outputs it with a much 
higher resolution (300 dots per inch) and much blacker 
black. Examples of LaserWriter copy are on pages 54-57. 

There are also very expensive (like $80,000), very high­
end printers with resolutions of around 2000 dots per 
inch, such as the Linotronic. These printers output onto 
film, not paper, and the hard copy looks virtually like 
traditional typesetting, limited only by the professional 
expertise of the person who input the type. This book 
was output on a Linotronic. 

Since the high resolution machines are so expensive, 
you only find them in a service bureau- a shop where they 
offer the output as a service. You would take the disk 
containing your document to them, leave it there, and 
they would print it up for you. It can cost from $6 to $10 
a page, but it's beautiful. 

Please read Chapter 13 on Fonts before you print your document. 

Printing to your ImageWriter or LaserWriter is very 
simple. Your application may give you different print 
dialog boxes depending on which printer you are 
connected to, and the dialog boxes wi thin different 
applications may look slightly different, but basica lly all 
you need to do is ans,ver the questions they ask. 

The first thing you want to do is to Save it again-as a 
preventive measure a lways save just before you print (one 

Preparing 
to Print 
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PRINTING 

Chooser 
0 Chooser 

never knows when the document-eating gremlins are 
lurking about). Also: 

• make sure the printer is turned on; 

• the ImageWriter must have its "Select" button 
on also. 

The very first time you print on your machine, or if you 

~ =x fl.! 
Se1ect o pnnter port. 

are hooked up to more than one printer, 
or if you go somewhere else and pr in t, or 
if you find you are having difficulty 
printing, you may need to go to Chooser 
to direct the computer to the printe r. I 

~ ~ I!IIBIZI Las~"ffrrtft' 

• 
User Neme 

!Rabin I 
In AppleTelk @Acl1ve 

0 lnecttve 

Chooser is a desk accessory that should 
be found under the Apple at the top left 
of your menu (also see page 79 for more 
info o n this). For every printe r icon in 
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lf01· 
~. 

lmageWritm· icon · 

LaserWriler icon 

Print 
Dialog Boxes 

331 

your System Folder, there will be a matching icon in your 
Chooser; even if you have a pri nter hooked-up right next 
to you, you won ' t be able to print to it unless its icon is in 
your System Folder. 

On the left side of the Chooser window you wi ll see those 
printer icons; click o n the one representing the machine 
you want to print to. On the right side should be a port 
icon or the name of a printer; click on the one you want 
to use. Make sure the network buuon (here it is Apple­
Talk) on the bottom is on if you are o n a network (which 
you would be if more than one computer is going to the 
same printer) and off if you are not. The LaserWriter 
also requires that Apple Talk be Active. Then just close 
the window and proceed. 

After your document is saved (and the printer is desig­
nated through Chooser, if necessary),just go up to the 
File menu and choose "Print .... " Depending on your 
application , you'll get some sort of dialog box asking you 
questions. Most of them are self-exp lanatory; the follow­
ing items are some typical sort<; of terms that may not be 
so obvious: 

Quality: Draft q uality on the ImageWriter prints 
very quickly, but elimina tes any graphics you may 
have had and produces really awful stuff; you can 
generally ignore this option unless you ' re in an 
extreme hurry and don ' t care a t all what it looks like. 



You can adjust the draft quality with the button on 
the Image Writer itself. If you turn off the Se lect light, 
you can push the Print Quali ty button to one of the 
three levels shown. You ' II get three levels of terrible 
type, from awful to worse. 

Orientation: Your applicatio n may use another te rm 
fo r it, but wha t Mac wan ts to know is if it should prin t 
upside right o r sideways (8.5 x 11 or 11 x 8.5); also 
known as Tall or Wide, Portrait or Landscape. 

Pages: All or From_ to_: You can choose to print 
all the pages contained in your document, or just 
pages 3 through 12 (or whatever your choice is, of 
course). Choosing All will override any numbers in 
the From/To boxes. 

50% Reduction: This will print your work at half 
size. Remember, half of an 8.5 x 11 is 4.25 x 5.5-
you must halve both directions. On paper, this looks 
like the image is~ the original size; it isn ' t-it's half 
of both the horizontal and the vertica l. 

Tall Adjusted: The Macintosh screen has a resolu­
tion of 72 dots per inch; the ImageWriter prints at 
75 dots per inch . Thus the ImageWriter tends to 
print large circles, such as pie charts, in oval shapes; 
choosing Tall Adjusted will fix that. It will also more 
closely resemble LaserWriter spacing; if you're using 
the lmageWriter as draft copies for eventual produc­
tion on the LaserWriter, this will help judge the work 
a little be tter. And it looks n icer anyway. 

Computer Paper: This does not refer to pin-fed 
paper! Computer paper is 11 x 13 inches. Pin-fed 
paper is 8.5 x 11 (le tter-size, just all strung together). 

When you click the last OK button , the messages will 
be sent to the printer and your brilliant document shall 
come rolling along in a short mo ment. 

Every time you turn on a LaserWriter, it spews forth a 
sample page fo r you to check the toner level and quality, 
as well as le tting you know how many pages have been 
printed on this toner cartridge. If you do n ' t want to waste 
paper or toner on this page everyday, simply loosen the 
paper u·ay before you turn it on . A minute or two af ter 
the LaserWriter stops whirring, push it back in . 

PRINTING 

The shaded portion is 
50% ofthe largl!l·siz.e­
half of both the width 
and the length. 

Save LaserWriter 
Toner & Paper 

' • 
69 



PRINTING 

70 

Align · When pri nLing from most applications you can deter­
lmageWriter : mine how far down from the top of the page you want 

Pin-Fed Paper . the documen t to begin. Unfortunately, the ImageWriter 
· doesn't know where the perforation of the pin-fed paper 

is; it just assumes it's at the top of the page and adjusts 
itself according to your specifications. In order to keep 
it consistent, so your documents always begin where you 
expect and line breaks will occur at perforations rather 
than in the middle o f documents, do this: 

l. Turn the printer on. 

2. Make sure the Select light is off. 
3. Press the line feed button until the perforation 

is just at the top o f the printer head (if you hold 
the button down , after four lines it will form­
feed until you let go). 

4. Prin t your work (take notice if you need to 
a rrange that first adjustment higher or lower; 
that is, above or below the printer head). 

5. When your work is finished printing, don't 
ever roll the paper forward manually in 
order to get to the perf to tear it off! That's 
exactly what causes the problem, because 
then it isn't lined up any more. 

6. Instead, turn the Select button off. 

7. Press the form-feed button; this will roll one 
entire sheet out of the printer, leaving the 
pe rforatio n lined up exactly how you just set 
it in step #3. 

8. Turn the Select light back on now so you 
don ' t forge t, since you cannot print with the 
Select light off. 

9. Now you can tear off your page, leaving one 
full sheet hanging out of the printer. 

Obviously, this is going to waste one page of paper per 
document. But it actua lly wastes less than if your docu­
ment printed right over the perforation marks and you 
had to reprint the whole thing! Another good aspect of 
doing it this way is that with that \Vhole sheet hanging 
out of the prin ter it doesn't get curled a round the roller 
and roll back inside itself when you try to print. You can 
always save the extra sheets for your kids, for scratch 
pape r, or have the local copy shop make pads for you. 



CLOSING/ 
QuiTTING 

When you are finished working on a document, you can 
choose to close that particular document in order to 
create a brand new one to work on, or to open one that 
has already been created. Either way, you are just closing 
the document and remaining within the afJplication (the 
software program). You still see the menu belonging to the 
application, even though the rest of your screen may 
look grey, just like your Desktop. 

If you don't see "Special" in your menu, or if the 
trash can is not there, you have not quit-you 
have just closed, but not quit. 

~[--• ___ F_il_e ___ Ed_i_t __ u_i_e_w ___ s_p_e_c_ia_l ____ ~l: 
If you don't see this menu, you are not at your Desktop. 

To really get back to your Desktop, where the menu 
items are File Edit View Special, you need to quit the 
application. This is always done from the File menu, the 
very last item. In most programs you can use the key­
board command: 38 Q. 

If you haven ' t saved all your changes, Mac wi ll politely 
ask if you want to save them at this point, whether you 
are closing or quitting. Thank goodness. 

If you never even initially saved the document with a 
name, you 'll get the Save As ... dialog box (page 64) to 

name it before qui tting, because no thing can be saved 
without a name. If you decide a t that poin t you don't 
want the document, just click the Cancel button. 

If you hold down the Option key while choosing 
"Quit," and keep holding it down, when you arrive a t 
your Desktop all the windows will be closed! 

If you are all done for the day, then close all your 
windows (hold the Option key down while clicking 
in the first close box, or try 38 -Optio n- W) ; from the 
Special menu choose "Shut Down." Any disks in the 
drives will pop out, and you can turn off the machine 
with the same button you used to turn it on . (More 
info on Shut Down on page 73.) 

CHAPTER SEVENTEEN 

Closing 
A Document 

Quitting an 
Application 

Shutting Down 
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CHAPTER EIGHTEEN 

There are actually many ways to eject a disk, some more 
preferable than others. Let's st.art at the Desktop. 

If you are done for the day and are planning to shut 
down the whole system, then close up all your windows 
(Command-Option-W for System version 6.0 or higher; 
make sure Caps Lock is not down). From the Special 
menu choose "Shut Down." This will eject any floppy 
disks and reassuringly notifY you that it is now safe to 
turn off the computer. 

Even if you're not ready to shut down, you may some­
times need to eject a floppy disk in order to trade it with 
another, or simply to t.ake your disk and go away. Begin­
ners usually go through the routine of selecting the disk 
(by clicking once on it) and choosing "Eject" from the 
File menu (or using the keyboard shortcut 3€ E). This will 
certainly work, but it actually is not the best method. 

Ejecting 

Shutting Down 

From the Menu 
or the 
Keyboard 
Shortcut 

You may have noticed when you eject a disk by using the 
menu that a grey version of the icon st.ays on the screen. 
That's because the memory of this disk is still in RAM 
(see page 63). If someone e lse comes along to use this 
machine while the icon is sti ll showing, when they insert 
their disk the Mac will very often spit it out and ask for 
the one that just left. That's not a problem if the disk is 
sitting right there, but if Mary took that disk and left for 
a meeting in Chicago, then the only thing you can do, 
absolutely your only option, is to turn the computer off. 
While that dialog box is showing "Please insert the disk 
"Mary"," you are stuck. Mac will accept no substitutes. 

Gre)' disk icon left on the 

screen after being ejected 

If you see a grey disk icon on your screen , you can try 
sticking it in the trash, but oftentimes even then you' ll 
get that dialog box. Occasionally pressing Command­
Period will satisfY Mac, but not often. 

To avoid this problem, while at your Desktop it is 
actually preferable to eject your disk through the trash. 

·Through 
the Trash 

Aack, you say! Yes, that's a frightening thought, but calm ! 
down; it's quite all right. The trash can doesn't erase anything · 
of!yourdisk. If you simply press on the disk icon, drag it · 
down to the trash and put it in, your disk will safely pop 
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EJECTING DISKS 

Through 
Dialog Boxes 

More Keyboard 
Shortcuts 

The Mouse Trick 
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' • 

The PaperClip 
Trick 

' • 

out and leave no grey icon behind. The computer now 
has no recollection of the existence of that disk and you 
can merrily be on your way and no one wi ll be mad at 
you for leaving yourself behind. This is especially impor­
tan t if more than one person uses the computer, as in an 
offi ce or in a classroom. 

Some dialog boxes give you an option to eject a disk 
while in an application: Save As ... ; Open in the Font/ 
DA Mover; and Open in any application, LO name a few. 
When you want to eject a disk while working, just choose 
something like "Save As .. . " even though you don' t really 
want to rename it; choose the disk you want to eject and 
click the Eject button (if you don't see the name of the 
disk, click Drive to find it in the o ther drive slot). Then 
click the Cancel button to get back to your document. 

After ejecting a disk in this way, you can of course insert 
a new disk if you like. If something from the ejected disk 
is still open on the screen, though, Mac wi ll ask for the 
ej ected disk again so she can put it away. 

• To eject a disk from the internal drive at any time, 
in any application, press Command-Sh ift-1 (tha t's 
the numeral One). 

• To eject a disk from the external drive at any time, 
press Command- Shift-2. 

• For a Mac with two inte rnal drives and an externa l: 
Command-Shift-1 ej ects the bottom inte rnal drive; 
Command-Shift-2 ejects th e top internal drive; 
Command-Shift-0 ej ects the external drive . 

If for some reason , perhaps because of a power outage or 
a system error, when you turn off the compute r your disk 
is still inside, do this: 

Hold down the mouse button ; while holding it down, 
turn the compute r back on; your disk/ s should pop 
out like toast. 

If all else fails, notice that tiny hole next to the drive slot? 
That 's paperclip size. Unbend·a paperclip and push it in. 
It's pretty safe, as all you 're doing is releasing the mecha­
nism that ho lds the disk in p lace-you d o have to push 
quite firmly, though. 



SHUTTING 
DowN 

Shutting down is the process of the compmer tying up 
all the loose ends inside itse lf and parking the hard disk 
before it's turned off. You can turn it off without shuuing 
down, but it's not recommended. 

When you 're done with the Macintosh, it's good house­
keeping to close up all your windows on the desktop. If 
you have System 6.0 or above you can press Command­
Option-Wand all the windows will fly away home (make 
sure the Caps Lock key is no t down). If you have an 
earlier System version , then hold down the Option key 
while you close the active window; all the rest wi ll fo llow. 

Once all the windows arc closed, from the Special 
men u ch oose "Shut Down." All your disks wi ll pop out 
and you' ll ge t a reassuring dialog box te lling you that 
you can now turn off your computer safely. 

Turn it off with the same button you turned it on, and 
away you go! On any of the Mac lis, "Shut Down" wi ll 
also automatically turn off the computer. 

CHAPTER NINETEEN 

ShuHing Down 

Good 
Housekeeping 
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DESK 
AccEssoRIES 

Desk accessories (DAs) are handy little tools found 
in your menu under the Apple, desig ned to make life 
easie r. Access them like any other menu item-slide 
down the list until it's high lighted, then let go. They're 
a ll windows, so they can be moved around the screen 
from their title bars and closed with the ir little close 
boxes. They all work from with in the System, so you 
can open any of them while you are in any application. 

You can buy an amazing number of desk accessories, 
many for very low prices. They do all manner of useful 
and useless things. This list explains just the ones that 
come standard with any Mac. 

The Alarm Clock won ' t wake you up in the morning, 
but it will beep a t you while you ' re sitting at your com­
puter. After it beeps once, the apple in the corner flashes 
o n and off; on the newer systems it flashes from an apple 
to an alarm clock. T he problem with this alarm is that it 
doesn't turn itself off- even if you turn orr the compute r 
and come back next week, the ala rm clock is still flash­
ing; you have to go get it and turn it off yourself. 

When the clock is the active window on your screen , you 
can press Command- C and create a copy of the date 
and time; set your insertion point d own anywhere, even 
under an icon at your desktop, and press Command-V; 
tl1e date and time wi ll paste into your document, like so: 
1:38:07 AM 7/ 5/ 90. 
0 To change the settings, begin by clicking o n the tiny 

fl ag on the r ight; it wi ll open up to a little conu·ol 
panel. After changing a setting, click anywhere in the 
clock window to put it in to effect. 

0 To change the time: 
• Click on the time clock icon on the bottom left; 

• Click on the number in the middle panel that you 
wish to change (this will cause little up and down 
arrows to appear on the rig ht); 

• Clicking o n th e arrows will move the time forward 
or backward or 

• You can t)'pe in the numbers o nce you select them, 
either from the keyboard or the keypad; 

CHAPTER TWENTY 

Desk Accessories 

Alarm Clock 
I 0 2:02:10 PM~ 
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DEsK AccEssoRIES 

A1rowJ with which to 
change the numbers 

The switch to I!Lm 
the alann on 01· off 

• Change A~! or P.\1 notation the same way. 

• Note: you can p ress the Tab key to move the 
selection from hours to minutes to seconds, e tc. 

0 To change the date: 

• Do the same as for the time, after clicking on the 
little calendar icon . 

0 To set the alarm: 
• Click on the alarm clock icon; 

• Change th e time to whe n you want it to go off, as 
detailed above (check the AM or PM no ta tion); 

• Click the little switch on the left to the up position 
(you' ll notice the zingers around the icon now); 

• When the alarm goes off, you' ll get a beep and/ o r 
your menu will flash, and the li ttle appl e in the 
menu will flash on and off. 

0 To close up the clock: 

• To just get rid of the control panel, cl ick on the flag 
in the upper right again ; 

• To put it away altogether, click in its close box. 
0 To turn off the alarm: 

• To turn it off temporaril)', but leave the a larm set for 
the next day at the same time, simply get the alarm 
clock and then click in its close box. 

• To turn it o ff permanently, you must go in and 
reverse the process of turning it on; that is, click 
on the alarm clock icon and turn off the switch . 

Calculator T he Calculator is a very handy item lO have. It operates 

78 

Calculator · just li ke your hand-held calculator, altho ugh it has only 
~mmam:mi) · the fo ur basic functions. Remember, it's a window so it 

can be dragged around like any other window and put 
away with its close box. Access it in any application. 

• Operate it with the mouse, keyboard, or keypad. 
• If using the keyboard, make sure you use the real 

numeral 1 (one) and not a lowercase I (el). 

• The division sign is the slash: / ; the multipl ication 
sign is the asterisk: * 

• The answer can be copied and pasted into your 
document using using standard methods; you don ' t 
need to se lect the calculator info first-if it's the 
active window, the Copy command knows what to 
copy. You can also copy numbers from your docu­
ment and paste them into the Calculator. 



DEsK AccEssoRIES 

The Chooser is where you choose which printe r you want Chooser 
to print to. If you are working fro m a hard disk ~~~~~~'"~··~··~· ~~~i!!!~ lr I St1tc l o pn nttr port 

either at home or at work and are hooked up to A ~ I [;Q;] 
only one pr in ter, or if you always use the same lliB!IIIIZI '"w•.-~ • 
System disk in the same computer, you need to . 
do this only the very fi rst time you print to that 
printer. 

0 Choose the icon for your printe r: 
• In the left-hand box are the icons for the prin ters 

whose icons are in your System Fo lder; 

• Click on the icon of the prin ter you are going to 
print to (in th is example it's the ImageWriter). 

0 Click on the name or the por t icon of your printer: 

• Depending on which prin ter icon you choose on 
the left, in the right-hand box you' ll see e ithe r 
names of the printers available, or port icons (the 
port icons are asking to which port, or plug o n the 
back of the Mac, your printe r is hooked); in th e 
example you see the choice of a printer port or a 
modem port (here the modem port is chosen, as 
the Lase1Writer is plugged into the printer port). 

0 Adjust the network option (a network lets more 
than one computer talk to the same printer; in this 
example it's Apple Talk): 

• If yours is the o nly Mac hooked up to an Image­
Writer, then AppleTalk will most likely be inactive; 
if several computers are sharing the same printer 
or if you are connected to a LaserWrite r, then 
AppleTalk should be active. 

0 If you type your name, you wi ll then have the pleasure 
of seeing your name on the screen . 

0 Click the close box and con tinue to p rint. 

The Control Panel allows you to customize the 
Mac to your own specific preferences, such as what 
kind of sound to make and how loud it is, how fast 
the insertion poin t flashes, the patte rn of your 
Desktop, e tc. What your particular Control Panel 
has in it depends on what system you are using 
and what is inside your System Fo lder. 

Many of the items are self-explanatory-j ust click 

II 
li!il 

' V..:cww 

[;;2) 

K"''tiO.Wd 

<l») 
....... 
' 

Ustr "-'mt 
jRcbtn 

Control Panel 
Control Ponel 

F! lhtt•fNff"tWI 

DLTIJ Peon\ Btr.WJ ...... 
I 

l>t-JkiOClP•ttff'n 0®0 

·~· '"' 
MtftUI!IncWI9 

,_ CS> 

'I ll 
72632 PM •· •· 

@ t 2tw- 02•~ .. . . . 
000® .... rfil 2. 

1 
Dfr ' 2 ' 6/ 7/69 0. 

in RAMCKM(B[] ® 00o ........ 
@Off ... ..... 

79 



DESK AccEssoRIES 

Click here to vinu 
patterns 1 1 

D ::::::: 
Desktop Pattern 

Click here to 
change your screen 

on the radio buttons or on the numbers or on the words in 
a scroll box to alter things to your fancy. Here are a few 
specifics for areas that may not be so obvious: 

0 Desktop Pattern 
• On the "Desktop Pattern" click on the tiny right 

and left arrows-this will take you through a variety 
of patterns; when you like one, click on the pattern 
under the arrows and your desktop will change; 
when you find the blank pa ttern, draw in it with 
the mouse to create your own-clicking on a white 
pixel turns it black; clicking on a black pixel turns 
it white, "erasing" it All patterns can be edited. 

· 0 Clock & Calendar 
• Setting the time and date he re will change the 

Alarm Clock desk accessory also, and vice-versa. 

11!!!!!!11 · 0 Keyboard 

Kf\1 Rf'put Ratt 

000®0 
S\o_. Fu: t 

7-
6 -
5-
4-
3-
2- t 

~-
Speaker 
Volume 
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d$¥111 
C>.l~ Unhl RtfM'~t I 
0 0®00 
Off Lor.o Short 

• Every key on the Macintosh keyboard will repeat, 
meaning if you hold the key down it will continue 
typing that character across the page. With the Key 
Repeat Rate panel you can control how fast it types 
that character across the screen. 

• With the Delay Until Repeat you can turn of! that 
function, so the keys wi ll not repeat when you press. 

• Long to Short is giving you control over how long 
you can hold your finger on a key before it starts to 
repeat. This is wonderful for people who are heavy 
on the keys- set it for a long de lay so if your fingers 
dawdle on the keys you won' t end up wi th extra 
characters all over the place. 

· 0 Sound 

Alert Sound Setting 

Boing 
Clink-Klank 
Monkey 

• J ust click on one of the sounds in the list box on the 

~ 

10 

right and you'll hear it at the level that 
you set your volume control. Whichever 
sound you choose last will be th e one you 
hear whenever Mac wants to beep at you. 
If you don ' t want to hear any sound, set 
the speaker volume to zero- your menu 
will flash instead. 



0 Mouse 
• The slower you set your mouse tracking spfed , with 

Tablet being the slowest, the far ther you have to 
move the mouse in connection with its response on 
the screen. In other words, if you have a ve ry small 
space for your mouse to move around in, then set 
this to the fastest speed-the pointer will move 
farther on the screen with the minimal amount of 
movement on the mouse pad. 

This is a most wonderful tool. There is a little man in 

c:> Hard Dlst 

Search ror. I resume 

" 0 Ru,.,... 

0fWit 1RtNM 

DESK AccESSORIES 

... '""\ 
l=n Click on this icon 
l!!!J to get to its controls 

0!1! 

(T.Citt) (r-b.df) 

0 000 ® 
v.,.,. Slow S'lov r.ut 

• • • • o • ® • o 
Do1A1 it·Cldc $pHd 

Find File 
rind rue 

• loo 

Find File who will find you anything you 
want, even if you have no idea where it is 
or exactly the name of it. It may be in a 
folde r which is in a folde r which is in a 
folder which is in a folder. Well , this guy 
will go get it-he'll look in every folder on 
your hard drive ar only in the folder or 
disk of your choice. He won'tlook in your 

c. .. ,,. . ,,,, ... \9, ,,.., • tt"" ~~ Wo"' Somptes 
Modin.d: "'" · .11u9 26, t98', 1 ., .v1 eg Work s 
Sit• : ~_::;~,k est Progr~:~ms 

~ Herd Disk 

refrigerator or under the sink. 
He'll no t only find your file, but if you ask 
will put it on the Desktop for you . Then wh 

him nicely he 
en you' re all 

through and don 't remember where it came from, j ust 
call him up and he will come right over and put it away 
for you , righ t back where it came from. What a guy. 

0 To locate a file: 
• the insertion point is flashing; you need to type in 

at least three le tters of the fil e name you want 
(actually, he will look even if you only give him one 
le tter , but if there are too many files with that le tter 
in it he gets mad and te lls you to be more specific); 

• if necessary, click on the name of the disk in the 
upper left to have him search another drive ; 

• click on the little man or press Re turn; 

• you can te ll him to stop looking at any time by 
clicking on the Stop sign with the hand on it; 

• the names of any files with those consecutive letters 
in it will show u p just below; 

• click on the name of the file you want and in the 
bottom right he will tell you exactly where ~tis 
located . Make a note ofwhere it is. If the scroll bar 
turns grey, press the ar row to see more. 

0 Put the file on the Desktop: 
• you can now either close Find File and go get your 

The particular file 
selected here 
is in a older called fi 
Works Samples, 
which is in a folder 
called Worlls, 
which is in a folder 
called Programs, 
which is on the 
Hard Disk. 
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file, or go up to the menu bar-notice you have a 
new item: Find File; 

• if you choose "Move to Desktop ... " from that new 
menu , the little man gets the fi le for you and puts it 
on the Desktop . 

. 0 Put the file away: 
• later, at your Desktop, when you want to put that 

particular fi le away and you don't remember where 
it came from, select it (by clicking once on it) and 
choose "Put Away" from the File menu; the li ttle 
man wi ll come and get it and put it away for you. 

· 0 From inside an application: 
• if you 're working on a job inside a program, then 

pull down Find File and enter a name in the box; 
• after he makes the list for you , click on the name 

of the fi le you want; 

• close the Find File window; 

• now when you go to the File menu in your applica­
tio n to Open a document, the one the li ttle man 
found for you will be waiting! 

Key Caps • If the icon Key Layout is in your System Folder, then Key 
• Caps can show you the keyboard layout for every fon t in 

DIIJ[ · your System. On a Macintosh keyboard you actually have 
llCJIC]( : fo ur separate sets of keys, two of which you know already 

Key Layout • and two of which o nly a few people know about. You are 

This is the icon that must • about to become In The Know. 

be in your System Folder • 
in order to view the 

sfJerial characters. • 

• afte r you open up Key Caps, you have a new menu 
item on the far right: Key Caps; 

• pull down the Key Caps menu-this is a list of the 
fon ts that are installed o n your System; 

• select the font you want; the characters of tha t 
font will appear o n th e keyboard (tl1ese are the 
characters everybody knows about); 

• to see the Shift characters, press the Shift key 
(everybody knows these, too); 

• to see the Option characters, press the Option key 
(Ha! You are now In The Know); 

• to sec the Shift- Option characters, press the Sh ift 
and Option keys simultaneously. 

• Different fon ts have different characte rs in the other two 
: keyboards-some have more, some have less. Most of the 
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Option key characters are consistent in every fo nt, so 
you can always fi nd, for instance , the accent manks or 
copyright, trademark, and monetary symbols, etc., in 
the same place. 

Key Caps is only for find ing the placement of all the avail­
able characte rs on the keyboard. Hold down the Option 
key, for instance, and see where the ¢. sign is located. 
O nce you discover that it is found under the 4 (the$ 

. Use Key Caps for 

. finding characters 

sign , logically), then you can go back to your document 
and press Option and 4; the ¢.will appear. It's exactly the • 
same idea as pressing Shift- S to get an asterisk! . 
It's possible to type the characters on the Key Caps • Copy & Paste 
keyboard, copy them (select the characters ftrst, then 
choose Copy from the Edit menu), an d then Paste them 
into your document (they will paste in wherever the 
insertion point is flashing). T his works fin e as lo ng as the • 
font you are using in your document is the same font you • 
chose from Key Caps, or at least that they share the same • 
character. Otherwise when you paste it in it will take on 
the fmmat (type font, size, style) of the characte r to the 
le ft of the insertion point, which may not be what you 
want at all. 

• At the Key Caps keyboard, find the character you 
want to use; 

• remember wha t font and what keys to press lO get 
that character; 

• go back to your document, select the font you want, • 
and press the appropriate keys; 

• can you find the apple? 

, •• 
Also see pages 46-4 7 fo r more info. 

The Note Pad is a nice li ttle feature that allows you to Note Pad 
write up to eight pages of notes. T his is a great place to • ~~Note Pod--

leave prearranged messages, notes about particular • ~·~~Y: ,~~: ~~~~t:~ li re 

formatting used in a document, reminders, or more love • 1 Yourotl1tuoe •syour llre 
2 Nox1m1ze your opu ons 

notes. T hey are automatically saved (they will not be 3 Never toke onyth•ng too 
sen ous ly 

destroyed on rebuilding the Desktop, as Get Info notes • Creol1ng memories ro rour 
Chllaren 

Will, p. 29) • o Every home sttou\0 hove o 
stoge and dance floor. 

T he insertion point is flashing; type into it just as you 
I • f.o-

type anywhere else in the Macintosh. You can backspace/ • 1"1 
delete, cut, copy, paste , e tc. T urn the pages by clicking b=ll= 1= ======::l 

• Click here to 
on the little turned corner on the bottom le ft; clicking 111m tlw /)(lge 

on the very bottom corne r will turn the pages backwards. • -----83 
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Scrapbook 

84 

·The Scrapbook is a place to permanently hold text or 
: graphics fro m virtually any program; then in any othe r 
• program you can take a copy of it back out from the 
• Scrapbook and paste it into your document. O nce you 
• put something in the Scrapbook it is saved to your disk 
• automatically. The Scrapbook hold s the e ntire object you 
: selected , even though you can ' t always see all of it in the 
• window. 

You must go through the Clipboard to fJUt items 
in the Scrapbook and to take them out. 

· 0 To paste something into the Scrapbook: 
• From your document, select and cofJY the item/ s you 

want to place (this puts a copy on the Clipboard); 

• Open the Scrapbook; 

• Paste the item into the Scrapbook (from the Edit 
menu choose "Paste ")-it will be pasted onto the 
page that is visible, and everything e lse will move 
over one; nothing is being replaced; 

• Close the Scrapbook to get back to your document. 
: 0 To copy an item out of the Scrapbook: 

• Open the Scrapbook 

• Scroll through until the item you want is visible; 

• Copy it (from the Edit menu choose "Copy"); 
• Close the Scrapbook; 

• Go to your document and paste it in (usually any 
text that is pasted in, and sometimes graphics, wi ll 
in sert itse lf wherever the insertion point is flashing; 
in some programs it wi ll just be pasted into the 
middle of the page). 

· 0 To delete an item from the Scrapbook: 

• Scroll through until the item you wanl is visible; 
• From the Edit menu choose "Clear" (Clear removes 

it from the Scrapbook without putting it on the 
Clipboard). 

Scrapbook Document 



TIPS & 
SHORTCUTS 

This is a collection of the tips or important notes that 
are imbedded in the rest of the book, as well as any other 
hints or fasc inating bits of information or shortcuts that 
haven 't been mentioned. Again, nothing is software­
specific; it all relates to the general Mac enviro nment. 
There's an extra page for you to add your own pieces 
of information as you move along with your Mac! 

CHAPTER TWENTY-ONE 

Caps Lock does not act like a typewrite r shift-lock in that · Compendium 
you can still type numbers while Caps Lock is down. p.l8 · of Tips 

To move a window without making it active, press 
the Command key while pressing-and-dragging in its 
title bar. p.20 

To a lign all icons horizontally with no empty spots, 
hold down the Option key while choosing "Clean Up" 
from the Special menu. p .23 

To close all the windows on your Desktop, hold down 
the Option key while clicking in the close box of the 
active window. p.23 

On Systems 6.0 and above, you can also close all the 
windows by pressing Command-Option-W. p.23 

Holding down the Option key while choosing "Quit" 
from any program will close all windows on the 
Desktop before you even get there. p.23 

Holding down the Option key while opening folders 
will make those folders close automatically when 
you return to the Desktop. p.23 

To print the contents of the active window on the 
ImageWri ter, pt-ess Command-Shift-4. p.24 

To print the entire screen on the ImageWriter, press 
Caps Lock down and Command-Shift-4. p.24 

To bring the window belonging to a grey icon to the 
front, simply double-click on it. p.27 

To avoid the dialog/alert box asking if you really want 
to throw away that application, ho ld down the Option 
key while trashing the icon. p.28 

'/he page number 
indica les where mare 

information on that tip 
can be found. 
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• After trashing an icon , "Empty Trash" from the Special 
: men u in orde r to free that space on the disk. p.28 

• To create a MacPaint file (a screen dump) of anything 
: on your screen , press Command-Shift-3. p .28 

• To write notes on a file, use the Get In fo box. p.29 

• Ho ld down the Option key to throw away a locked 
· file. p.30 . 
. Use folders to organize your Desktop and all your 
• di sks as you would your fi ling cabinet. Chapter 9 (p. 31) 

• Create a new folde r a t your Desktop before you begin a 
• project and save all your related parts into that folder, 
• preventing them from getting misplaced . p .33, 64 . 
• To select more than one icon a t a time, press-( in any 
• blanh area)-ancl-cl rag the po inter; a marquee will appear. 
• Anything enclosed in th is marquee will be selected. To 
• move them all at once, press in any blach area (except 
: on the name) and drag; all the outli nes wi ll move 
• simultaneously. p .35 

: Anoth er way to select more than one icon, especially 
• when the icons are not near each other , is to Shift-Click: 
• press the Shift key while clicki ng on icons and every one 
• you click will be selected. Conversely, deselect any by 
• pressing the Shift key-only the ones you click will be 
: deselected from the group. p. 36 

• If you press the Option key while moving an icon from 
: one folder to another, it will move a copy of it. p.36 

· Never hit the Return key while typing un less you 
• really do always wan t the line to end at tha t word. p.40 

• If you are going to center a line, don ' t use tabs or 
• indents or spaces before or after th e line or they will 
: make it appear off-center. p.42 

· While typing, the insertion point picks up the 
· formatting of the characte r to its left-fon t, style, size, 
: align men t, and rule r settings. p .43, 47 

• To remove all the styles a ttached to characters (bold, 
• italic, shadowed, etc.), simply select the text and choose 
: Plai n or Normal. p.43 

• While typing, use the keyboard commands to change 
: the style (to ita lic, bold , e tc.) of the next word/ s to be 



typed ; choose the style again to take it off. This dvoids 
having to select the word/s, pick up the mouse, J1se the 
menu, and set th e insertion point again to contil1ue. p.43 • 

Don ' t forget about Undo! If something happens that 
you didn 't want to happen or don 't like, beforeymt rio 
anything else, even before you scream, UNDO (fro m the 
Edit menu , or Command-Z) . p .46 

Use the Op tion characters to place accent marks over 
letters. p.48 

Use only one space after sentence ends! p.48 

Never use a typeface with a city name on the 
LaserWrite r. p .S0-51 

vVhen saving, be sure to save directly into the folder 
you created to store your work. p.33, 64 

Make several versions of your work using "Save As .. .. " • 
p.65 

If you change your mind about the changes you j ust 
made, close the document and don ' t save those changes; • 
when you reopen it, it will have reve rted back to the last- • 
saved version. p .65 

To avoid wasting paper and toner every time you turn • 
on your LaserWriter , pull the pape r tray o ut a bit before 
you turn it on. p .69 

When ejecting disks at your desktop, rather than 
ejecting them with the menu command it is preferable 
to drag them out through the trash can. This doesn ' t 
destroy any data on the d isk, and removes the memory of • 
that d isk so the computer doesn 't a~k fo r it again. p.73 

If a disk is stuck in the computer after the computer 
has been turned off, hold the mouse button down while 
turning th e machine back on; the disk will po p out. p.74 • 

As a last resort to eject a disk stuck in the computer, 
unroll a paperclip and push it in the tiny hole to the 
right of the drive slo t. T h is will release the mechanism 
and pop the disk ou t. p. 74 

To find a file / documen t/ application that some?ow got 
misplaced but you know it's in there somewhere, use 
Find File from the Apple men u. p.S l 
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A Few ExTRA TIPS 

Real 
Quotation 

Marks! 

•• and~~ 

'and~ 

not 11 and 1 

: Using inch and foot marks in p lace of the real quotation 
• marks is a big problem with so much of the work that is 
• being produced on the Mac. Yes, o n the typewriters we 
• grew up with we used those marks, but we are no longer 
• on typewriters and are not so limited . Also, we are 
• attempting to come close to professional type, and you 
: never see inch and foot marks used as quotation marks 
• in professional type. Unfortunately, they are not located 
• in an obvious spot, so you won 't know they're there 
• unless somebody tells you. So here you are: . 
• To create these beautiful marks in any font (and 
• you 'll always be able to find them in Key Caps), use 
: the following keystrokes: 

" option - [ 

option - shift- [ 

• option-] 

option - shift- ] 

They won't always be 
these big round marks; 
each f ont has its own 
quotes designed for it . 
See the font lists on 
pages 53-57. 

Return Key · Anytime you see a double border around a button (such 
Shortcut · as the one shown below), that means you can press the 

: Return or Enter keys to do that function, instead of 
• picking up the mouse and clicking on it. 

n OK D ( Cancel ) 

Replacing ·When text is highlighted, you don 't need to de lete it 
Highlighted Text · fi rst in order to type in what you want. When text is 
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: highlighted, simply type; your typing will replace the 
• highlighted word/ s. This is true anywhere in the Mac-
• all dialog boxes, all programs, even on the Desktop when 
• changing the name of an icon. 

Ellipses ... . Three dots (the ellipsis: ... ) afte r an item in the menu 
in the Menu · means you'll get a dialog box if you choose that item. 

• Anything that doesn't have the ellipsis wi ll just ac tivate 
: as soon as you choose it. 
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In any dialog box that contains boxes for you to fill in , · Tab in 
you can press the Tab key to move you from box to box. . Dialog Boxes 
If there is data already in the box, it will be highlighted 
and anything you type will replace it (you don't have to 
delete it first) ; if there is no data in the box, the Tab key • 
will set the insertion point there, ready for you to type. 

On the front of the Macintosh, if you slip your hand • Dimmer Switch 
right under the rainbow apple, you'll find a little roller 
switch that will dim or brighten your screen . It's a good 
idea to dim the screen if you're going to be away from 
the computer for a length of time, as it's possible to burn • 
an image into the screen, just as on video games. 

There are several varieties of "screen savers" available to • Screen Savers 
help avoid screen bum. A screen saver usually turns the 
screen black and has images that constantly move, like 
shooting stars or geometric shapes or fireworks. As soon • 
as you click the mouse it disappears. Some come as desk • 
accessories that you access through your Apple menu; 
some you put in your System Folder and they automati-
cally come o n after a certain period of time if the keys or • 
mouse haven ' t been touched . Simply clicking the mouse • 
will restore the screen. 

Several of the paint programs allow you to create a • StartupScreen 
StartupScreen. Once you have a StartupScreen installed • 
in your System Folder, every time you boot (start the 
computer) with that System, this image will show on the 
screen for a minute or two. This can be quite fun! To do • 
it, simply create a paint document, or use clip art, and 
save it with the name "StartupScreen." It doesn ' t matter 
what letters are capitalized, but it does have to be one 
word. Put that file into the System Folder. The next time you • 
boot, you 'II see it! • 

· Copying From 
· One Floppy to 

If you need to copy something from one floppy onto 
another floppy but your machine has only one floppy 
drive, this is how to do it: 

• Insert the disk you want to copy onto. While it is 
selected (click once on it if it isn't), from the File 
menu choose "Eject." Remember, this ejects the 
disk but leaves it in RAM (p. 63). You should see 
the grey icon after the disk ejects. 

. Another Floppy 

. with One 

• Insert the disk with the information to be copied 
from. Open it and select the files to copy: press-

· Floppy Drive 

89 



A fEW EXTRA TIPS 

90 

Rebuilding 
Your Desktop 

and-drag them over to the grey disk (or just drag 
the icon of the entire disk lO the other disk, which 
wi ll replace eve~ylhing). 

• As Mac reads info from one disk and copies it onto 
the other, she will spit out disks and tell you which 
ones to insert next. Just follow the d irections; this is 
called disk-swapping. It will eventually end. 

• If you end up with a grey disk icon on the screen , 
just drag it out through the trash. 

• If you have a hard disk, you may start to notice that it 
• slows down after a few months. This is because there is 
: an invisible fi le that keeps track of all the icons that have 
• ever been seen on your desktop, even if you just loaded 

NOTE: · them on to see what they looked like! There is a way to 

This process will · rebuild your desktop and remove all the unnecessarily­
also destroy the · stored information. Follow these steps: 

WDEF virus! . 
1. Turn off the Mac. 

2. Hold down the Command and Option keys. 

3. Turn the Mac back on, still holding down those 
keys until you see the following dialog box: 

n OK 

Rre you sure you w ont the desktop 
rebuilt on the disk "Hord Disk "? (This 
moy toke o few minutes.) 

)J ( Cancel J 

4. Click OK (or, if you read the tip on the previous 
page, simply hit the Re turn key). 

• Rebuild floppy disk desktop files the same way: 
hold the Command and Option keys d own while 
inserting a disk, unti l you see the above dialog box . 

• Mac will rebuild the desktop file for you and it should 
• now open and close files and folders much faster, plus 
• rid it of the rude and evil WDEF virus. 
: The only problem with rebuilding is that it also destroys 
• any messages you put in your Get Info boxes. Darn it. 
• (See page 29 for info on Get Info .) 

Check Your . To see what fo nts are in th e System while you are still at 
Fonts at the · your Desktop, fro m the Apple menu choose "Key Caps." 

Desktop · At the far riglll of the menu is a new menu item: Key 
: Caps. Press on it to see the list of System fonts. 



AAACK!! 
HELP! 

This list doesn ' t pretend to be an all-inclusive reference 
for every sort of catastrophe that may befall ; rather, it is 
just a compi lation of the most common, simple problems 
one may encounter when first beginning to work on a 
Macintosh. 

If the computer doesn ' t turn on, check all your switches 
(when the switch is labe led 1 or 0, the 1 means On): 

• If you have a floor surge-protector bar with an 
on-off switch on it, it may have been kicked to 
the offposition-make sure it is on. 

• If your hard disk is external , it has its own on-off 
switch that must be turned on jiTst so it can boot 
up; then the Mac must still have its own switch 
turned on also. 

• If your compute r has a fan unit on top with 
buttons to push, those buttons still won ' t ·work 
unless the switch on the back of the compute r 
is also on. The button on the left of the fan unit 
typically star ts the Mac, while the button on the 
right will stan your hard disk (but the hard disk 
itself should be turned on first). 

• If your Mac II starts from the keyboard switch , you 
must make sure the switch on the back of the Mac 
is also on. 

You're trying to start your computer and Mac just spits 
o ut your disk and/ or gives you a big X. This usually 
happens because Mac can't find the System Folder. If 
you are using an external hard disk, make sure the hard 
disk unit itself is turned on, as well as any peripheral 
switches. If you are using a floppy disk, the disk you are 
inserting does not have a System Folder on it. Or it may 
have a System Folder, but the System Folder doesn't 
contain the System icon and/ or the Finder icon. Both 
icons must be on the disk; and actually, both icOJ1S 
must be in the same folder and the folder really must 
be named "System Folder" or confusion may result 
(even on a hard disk). 

CHAPTER TwENTY-Two 

·What To Do If: 

. The Computer 
Doesn't Turn On 

: The Flashing X, 
. or The Disk 
. Gets Spit Out 

·. 
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The Screen Occasionally the computer screen just up and freezes. 
Freezes : The pointer may move around, but you can't click on 

anything and it doesn't respond to the keys. Most often 
this is the result of static electricity. Try unplugging th e 
mouse and/or the keyboard for a minute or two; plug 
it back in and the screen sometimes unfreezes. If th at 
doesn' t work, then you just have to turn the machine 
off. Yes, you wi ll lose everything that hasn 't been saved , 

· which is one of the reasons you should SOS (Save Often , 
· Stupid!. .. e r, Smartie!) . 

Can't Find 
Your Document 

In the beginning you may very often save a document 
· dutifully, but th en when you get to your Desktop you 

Can't Open 
a File 

· can 't find it anywhere. This is because when you saved it 
: you weren ' t paying attention to which disk and/or folder 

you were saving it into. Be sure to read the chapter o n 
Saving (pages 63-65, as well as 33- 34), and carefully 
look at the dialog box pictured there so you understand 
how to save it into the righ t p lace. 

Anyway, at the momen t you can 't find it. Never fear, Mr. 
Find File is here! Read about this guy on page 81-he'll 
go get your file and hand it right over to you. 

When you find your file, put it in a fo lder you have 
created (page 3l ), just as if you were going to put it in 
a fi le folder in the fi ling cabine t. Press-and-drag the fi le 
icon over to the fold er or disk of your choice. T he 
folder/ disk should turn black; when it's black, let go 
and the document will drop right in. 

Sometimes when clicking o n an icon you get a message 
box that te lls you the fi le is locked or in use, or maybe 
that an application couldn 't be found. 

[Iii 14 items 

This symbol indicates the · 
disk is wcked. 

If the disk is locked, you' ll see a li ttle lock symbol in the 
upper left of the window when you open it. When a disk 
is locked you can 't save to it, nor can you p rint from a 
locked System d isk. To unlock it, first eject it. In one of 
the corners is a li ttle b lack tab that covers or uncovers a 
hole. When the ho le is open, the disk is locked (seems 
backwards, doesn ' t it?). So to unlock it, switch the tab 
back so the hole is closed. (More info on page 7.) 
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If the file is locked, click once on it and choose "Get 
Info" from the File menu. In the upper right corner 
th ere is a li ttle box named "Locked" that may be 



checked. If it is checked, then clicking in the box will 
uncheck it and thus unlock the file . 

If the file is in use, then it's in use. Usually you get this 
message if you ll)' to open one of the icons that looks 
like a Macintosh; those are part of the System. 

If it tells you an application can't be found, then one 
of two things is happening: 

• The software application that the document was 
created in is not in the computer. Even though your 
document icon may look like SuperPaint, in orde r to 
view the document it has to go into the application 
SuperPaintto create itse lf. 

• Some files cannot go straight from the Desktop 
to the application, even if the application is in the 
compute r also. In this case, if you know the docu­
ment was created in a certain application and you 
know tha t particular application is in your machine, 
then you must go into the application itself (double­
click on its icon) and open the file you want from 
inside, choosing "Open'" from the File menu. 

When ll)'ing to view clip an, often you will get the 
message that "An application can't be found," even 
when the program it was generated in is on the disk. You 
need to open the actual apj1lication itself, then open each 
individual document through the File menu, choosing 
"Open " (such as YfacPaint, or SuperPaint with the 
MacPaint button selected in the Open box). 

If you are experiencing system bombs too regularly, 
the most common reason is that you have more than 
one System in your computer. One System is essential; 
two Systems is too many. Eve n though you don ' t see 
something call ed System Folder rig ht there on your 
Desktop doesn ' t mean you don't have one tucked away 
in the depths of several other folders somewhere. 

If you have a hard disk, don ' tuse a floppy that also has 
a System on il. If the document you need is on a fl oppy 
with a Syste m Folder, cojJ)' the dowment onto yom· lza1·d disk, 
ejecllhe jlojJ/J)', rmrl &jJen lhe dorummt from the hard disk; you 
can copy the revised file back o nto the floppy when 
you ' re d one. 

HELP! 

· Viewing 
. Clip Art Files 

System Bombs 
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HELP! 

Find any · An easy way to find all the Systems on your hard disk and 
extra Systems · on any floppy disks you are using is to ask Mr. Find File 

(read all about him on page 81). Move them all (except 
one-save the latest version! ) to the Desktop and throw 
them in the u·ash . If you hold down the Option key while 
trashing them, you can avoid th e nice dialog box that 
asks if you're sure you want to do this. You won't be able to 
lhrnw away the System that is booting the machine. 

Understand, though , that each System has its 
own collection of fonts and desk accessories. 
If you have customized a System Folder, save 
that one. 

Text FormaHing 
Unexpectedly 

Changed 

It's not uncommon to open a file on another System 
and find maj or formatting changes. If you created a 
document on your hard disk using the font Palatino, 
then gave a copy of the document on disk to a co-worker 
who ope ned it up and found it had transmogrified itself 
into the font Helvetica, meaning all your formatting 
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Printing 
Doesn't Work 

· was thrown off, that's because Palatino was not in the 
co-worker's System. If the document can't find the font 
it was specified in, then it has to choose another from 
what is available. The only solution is to make sure both 
Systems have the same information in their System 
Folder and font fi les . 

. This may happen occasionally even if the fonts are the 
same in both Systems. Another possible reason for this 
is that some programs create a fi le in the System Folder 
that ho lds the formatting for the document. When you 
open up the document with a diffe ren·. System Folder, it 
can't find its formatting. If you know you are going to be 
taking that document to another computer, as soon as 

· you quit creati ng it, go into the System Folder and find 
· the formatting file; e.g. Word Settings if you are using 

Microsoft Word. Renam e that fi le to correspond with the 
file you just created (though not exactly the same name), 
and put them both in the same folder. 

• One of the most common reasons why printing won ' t 
work is because the appropriate printer icon wasn' t 
chosen. Go to Chooser from the Apple menu and 
choose your printer (see pages 68 and 79). 



• Make sure the printer is on , that it has paper, and 
that the paper tray, if there is one, is firm ly attached. 

• Make sure any networking cables are conn ected . 

• On an Image Writer, make sure the Select light is on. 
It must be on in order to print. 

• Also on an Image Writer make sure the lever on the 
hand roller corresponds to the way you are feeding 
paper-that is, friction-feed for single sheets (that's 
the symbol with two rolle rs, towards the back); and 
pin-feed for pin-fed labels and paper (that's the 
symbol with one roller and little pins, pulled towards 
the front). 

• If the disk that the System J;older is on has less than 
about 15K available, Mac can not print. She needs 
some free space to send over the messages for 
printing. Yo u will have to free up some space on 
that disk by removing a fi le or two. 

• Sometimes gremlins prevent printing properly. If 
you have checked everything and there really seems 
to be no logical reason for it not to print, go away for 
a while, let someone else print to that printer , shut 
down, come back later, try again. This sometimes 
works. One never knows. 

• Unusual printing problems are a common symptom 
of a virus attack. There is a great deal of literature 
available on the topic of viruses; check with your 
compute r dealer for information and for tl1e software 
avai lable for detection and eradication. If you think 
you have the WDEF virus, read about rebuilding your 
Desktop to destroy it, page 90. 

If you want to form-feed or line-feed the paper, the 
Select light must be off. Be sure to turn it back on again 
before you try to print! 

Notice that th e line-feed button will feed the paper 
through one line at a time for four lines, then it turns 
into a controllable form-feed; as soon as you let go it 
stops. Form-feed itself will roll through an entire page 
length (generally II inches). 

HELP! 

Can't Form-Feed 
or Line-Feed the 
Image Writer 
Paper 
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HELP! 

There's Garbage 
Hanging Around 

Outside the 
Trash Can 

If garbage piles up around your can , it's because you 
didn ' t put it inside the can , but set it down outside, just 
like the kids. Whe n the very tip of the pointer touches the 
can and turns it black, that's the time to le t go. It doesn' t 
matter if the icon itself is positioned over the can- it's 
the pointer tip that opens the lid. 

Grey Disk Icon is · A grey disk icon can mean one of two things, either it is 
Left on the Screen · open or it is in RAM. 

liJ.,li.~,l~=.,,=.~ ',,=.lll,l'~, :~:.;~~~ ;~:~r;s .::=:"; ,::;.: ~::t:~~~~:.;~~::~r;er 
clicked on it and its window is open somewhere on 

Grey dish icon left on the . the screen. If you can ' t see it because the re a re o ther 
screen after being ejected · windows in the way, simply double-dick on the grey 
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· shadow and it will come forth as the active window. 

· If the disk itself is not in the floppy drive, then you most 
like ly ejected that disk by choosing "Eject" from the File 
menu or by pressing Command-E. This procedure does 
eject the disk, but a lso leaves its information in Mac's 
memory. Read page 73 for a thorough explanation of 

. what happe ned and how to avoid it. 



Use these pages to record any new tips or 
shortcuts or troubleshooting techniques you 
happen to discover or read about. 

YouR TIPS 
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More of your : 
own tips . 



Accent marks, 48 Close Viewing fonts from, 90 
Active Window, 19-20, 21 Box, 19,21 Dialog boxes, 16 
Alarm Clock, 77-78 Documents, 71 Fonl/DA Mover, 60-1 
Alert box, avoiding, 28 Windows, 19, 21,75 Save As ... , 16, 33-4 
Alignment, 44 All windows, 23, 75 Ope n, 38 
Apostrophes, 52, 88 Close box, 19, 21 Print, 68-9 
"Application can't be Command key, 16-1 8,46 Rebuilding, 90 

found," 93 Typing 3€, 104 Dimme r switch, 89 
Application icons, 26 Computer paper, 69 Disk icons, 25 
Applications, 37, 26 Control key, 18 Grey, 73,96 

Trashing, 27, 28 Control Panel, 79-81 Disks, 6 
Avant Garde, 50, 57 Copy,35,36, 44,45,89 Backup, 8 
Backspace, 17, 39 Alarm Clock, 77 Capacity of, 6, 7, 21 

re: Clipboard, 46 Calculator, 78 Caring for, 6 
Backspace key, 17, 39 Duplicate, 36 Ejecting, 73-4 
Backup disks, 8 Files, 35 Floppy, 6, 21 
Bit-mapped fon ts, 49-55 Floppy-to-floppy, 89 Grey, 25, 73, 96 
Bits, 5 Folders, 32, 35 l-Iard disks, 7, 21 
Blank space in text, 41 Keyboard shortcut, 46 Icons, 25 
Bomb, 93 More than one fi le, 35 Initializing, 6 
Bookman, 50, 57 Onto same disk, 36 Inserting, 10 
Boot up, 9, 10 With Scrapbook, 84 Locked, 7,92 
Bytes, 5 Control key, 18 Rebuilding Desktop, 90 
Calculator, 78 Courier, 49, 50, 56 Renaming, 30 
Calendar, 77-8 Cut, 44, 45, 84 Unlock, 7, 92 

Clock, 77-8, 80 Keyboard shortcut, 46 Document, 14 
Comrol Panel, 80 DAs (see Desk Accessories) Icons, 26 

Caps Lock, 18 Delete, 17, 39 Can't find, 92 
Cente ring text, 42 re: Clipboard, 46 Can't open, 92 
Chicago, 49, 53 Delete key, 17, 39 Find ing, 81-2, 92 
Chooser, 68, 79 Deselecting fi les, 36 Get Info, 29 
City-named fonts, 49-57 Deselecting text, 40 Lock,30 
Clean Up Window, 23 Desk Accessories, 77-84 New vs. Open, 38 
Click (see also Icons) Alarm Clock, 77-8 Opening, 26, 37 

and-drag, 13 Calculator, 78 Size of, 22, 29 
Double, 13, 40 Chooser, 68, 79 Unlock, 30 
Hot spot, 14 Control Panel, 79-81 Double-clicking, 13, 40 
In the scroll bar, 21 Find File, 81-2 Text, 40 
Press, 13 Font/ DA Mover, 59-62 Icons, 25-28 
Press-and-drag, 13 Key Caps, 47-8, 82-3 Downloadable fonts, 62 
Single , 13 Scrapbook, 84 Drag, 13,40 

Clip art, viewing, 93 Desktop, 10, 11 Drive 
Clipboard, 44-45 Changing the pattern, 80 Exte rnal, 10 
Clock Menu, 15, 71 l-Iard , 7, 9 

Alarm, 77-8, 80 Organizing, 11 , 12 Internal, 10 
Comrol Panel, 80 Rebui lding, 90 Duplicate fi les, 36 
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[jcct, 73-4 City-named, 49-5 1 Grey, 27, 73, 96 
Floppy to copy, 89 Cut & Copy, 44, 45 Highl ighted, 27 
From dialog boxes, 74 Downloadable, 62 Locking fi le, 30, 92 
From keyboard, 73 Family, 62 Moving, 30, 35, 36 
From me nu, 73 Highlight text, 20, 21 Naming, 30 
Shut Down , 71,73 ImageWriter, 49-55 Open, 27 
Through trash, 73 Important info, 50-1 Printer, 26 
With mouse, 74 Interesting info, 49 Removing, 27 
With paperclip, 74 LaserWriter, 49-52, 56-8 Renaming, 30 

Ellipses, 16, 88 Moving, 52, 59 Screen dump, 28 
Empty trash , 27 Paste, 45, 46 Selected, 27 
En ter key, 18 PostScript, 49-52, 56-8 Software, 26 
Escape key (esc), 17, 18 Printer fonts, 52 System, 25 
Extended keyboard, 17 Printers, 49 Trash can , 27, 73 
External drive, I 0 Screen fonts, 52, 59 Undo name change, 30 
File (also see Document, Sizes, 5 1 View by, 22 

Application ) Special char 's, 46-7, I 04 ImageWriter. 67, 68 
Get Info, 29 Standard, 49-50 Chooser, 68 
Find File, 8 1, 82 Traditional, 49 Fonts, 49-51, 53-5 
In Use, 93 View from Desktop, 90 leon, 68 
Locked,30,92 Where they reside, 59 Paper feeding, 70 
Renaming, 25, 30, 31 Form-feed , 70 Printing to, 68, 69 
Unlock, 30, 92 From/ To, 69 Information bar, 21 

Find File, 81 , 82 Frozen screen, 91 Inserting a d isk, 10 
Finder, 9, 10, 11 Geneva, 49, 50, 53-5 Insertion point, 39, 43, 47-8 
Finder icon , 9 Get Info, 29 Internal drive, 10 
Floppy d isks (see Disks) Greyicons,20,27, 73 Key Caps, 47-8, 82-3 
Folders, 25, 31 Grey d isk icon , 73, 96 Keyboard, 17 

Copying, 32 Grey scroll bar, 19, 20, 21 Backspace key, 17,39 
Creating, 31 Hard copy, 67 Caps Lock, 18 
Icons, 25, 31 Hard disk, 7 Command key, 16, 46 
Information, 19, 21,29 in ternal, external, 9 Control key, 18 
Naming, renaming, 3 I Hard return , 40 Control panel, 80 
Open ing, 32 Help, 9 1-8 De lay unti l re peat, 80 
O rganizing with, 32 Helvetica, 49-51, 55-8 De lete key, I 7, 39 
Put something inside, 32 Hierarchal file syste m, 32 Enter key, 18 
Remove something, 32 Highligh t text, 40-2, 88 Escape key, 17 
Saving imo, 33, 34 To unhighlight, 40, 88 Extended, 17 
Trashing, 27 Highligh ted icons, 27 Key repeat rate, 80 

Font/ DA Mover, 59-62 Hot spot, 14 Option key, 18 
Fonts, 49-58, 62 !-Beam, 39 Return key, 18 

Accent marks, 48, I 04 Icons, 25 Shift key, 18 
Bit-mapped, 49-55 Application, 26 Shortcuts, 16, 46 
Changing, 42 Black, 27 Spacebar, 18 
Changing al ignment, 44 Copy, 35,36 Standard, 17 
Changing style, 43 Disk, 25 Tilde key(-), 17 
Changi ng style from Document, 26 Keyboard shortcuts, 16, 46 

the keyboard, 43 Duplicate. 36 Ki lobytes, 5, 2 I 
Changing type size, 43 Folder, 25 Ks,5, 21 
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LaserWriter, 48, 50-2, 56-8, 
68 

Saving toner & paper, 68 
Line-feed, 70 
Line up pin-fed paper, 70 
Linotronic, 67 
Locked d isk, 7, 92 
Locked file, 29 
Marquee, 35 
Megabytes, 7, 2 1 
Megs, 5 
Memory, 63 
Menu, 15 

Choosing commands, 15 
Desktop, 71 
Ellipses in , 16 
Greyvs. black items, 15 
Keyboard shortcu ts, 16 
Pull-down, 15 
Pop-out, 16 

Monaco, 49, 50, 53-5 
Mouse, 13, 81 

Cleaning, 14 
Double-dick, 13 
Pointer, 14 
Press-and-drag, 13 
Press, 13 
Single-click, 13 
Speed control, 81 

Name icons, 30-1 
Files/ folders, disks, 30-1 

New ... , 38 
New Century Schlbk, 50, 57 
New vs. Open , 38 
New York, 49-55 
Note Pad, 83 
Open ... , 38 
Open dialog box, 38 
Open icons, 27 
Open vs. New, 38 
Opening 

Applications, 26, 37, 38 
Documents, 26, 37, 38 

Option key, 17 
Accent marks, 48 
Alert box, 28 
Closing all windows, 23 
Duplicating, 36 
Quitting, 23 

Organize, l l , 12, 32 
Orientation, 69 
Palatino, 50, 56 
Paper 

Computer pape r, 
Lining up pin-fed , 70 
Saving LaserWri ter, 69 

Paste, 45 
Keyboard shortcut, 46 

Pe riods, o ne space, 48 
Pin-fed paper, 70 
Pixe l, 43 
Pointer, 14 
Pop-out menus, 15 
Port, 79 
Power User, 23 
Press, 13 
Press-and-drag, 13 
Print (also see Fonts) 67-9 

Dialog box, 68-9 
Doesn ' t work, 94 
Screen, 24 
To ImageWriter, 67, 68, 70 
To LaserWri ter, 67 
To Lino tronic, 67 
Window, 24 

Print Window, 24 
Print Screen, 24 
Printer icons, 26 
Printers (see ImageWriter , 

LaserWriter, Linotronic) 
Programs, 37 
Pull-down menu, 15 
Put Away, 27, 82 
Quality, 68-9 
Quit, 7 1 
RAM, 45,63 
Random Access Memory, 63 
Re building the Desktop, 90 
Reduced size, 69 
Remove fonts o r DAs, 59-61 
Rename icons, 31 
Return Key, 18, 40 

Double-space, 41 
Hard return, 40 
Removing a return, 4 1 
Word wrap, 40 

Revert, 65 
Rule # 1, 63 

INDEX 

Rule #2, 42 
Rule #3, 8 
Save, 33, 34, 63-5 

SOS, 63 
Save As ... , 33, 64 

Dialog box, 33-4, 64 
Diffe rent versio n, 65 
Into your folder, 33-4 
Mini-menu in , 34, 64 
Onto your d isk, 34, 64 
Onto another disk, 64 
Reverting, 65 

Scrapbook, 84 
Screen 

Cha nging pattern, 80 
Desktop, 10, I I 
Dimmer switch, 89 
Frozen, 91 

Printing, 24 
Screen savers, 89 
StartUpScreen, 89 
Screen dump, 28 
Scroll arrows, 19, 20 
Scroll box, 19,21 
Scrolling, 20 
Select first, then operate , 42 
Selecting 

Blank space, 41 
Icons, 25-7 
With marquee, 35 
More than one icon , 35 
Rule #2, 42 
Shift-clicking, 36 
Text, 40-2 

Service bureau, 67 
Shift-cl ick, 36 
Shift key, 18 
Shortcuts (see Keyboard) 
Shut Down, 7 1, 73 
Size box, 19, 20 
Software, 26, 37 

(also see Application ) 
SOS, 63 
Sound,80 
Spacebar, 18 
Specia l characters, 46-8 
Special menu , 75 
SLandard keyboard, I 7 
SLarting up, 9 
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INDEX 

Start-up disk, 10 
StanUpScrcen, 89 
Style , changing, 43 
Symbol font , 49, 56 
System, 9, 10 
Syste m bombs, 93 
System Folder, 9 
System icons, 9, 25 
System versions, 10 
Tab key in d ialog boxes, 89 
Tall Adjusted , 53, 69 
Text (see Fonts, Typing) 
Tilde key(-), 17 
T imes, 49-52, 56, 58 
Tips, 85-90 

Compendium, 85 
Dimme r switch, 89 
Ellipses in menu, 88 
Quotation marks, 88 
Re building desktop, 89 
Re turn key shortcut, 88 
Screen savers, 89 
StartUpScreen, 89 
Tab in d ialog boxes, 89 

Title bar, 19 
Toggle switch, 43 
Toner saver, 68 
Trash can, 27 

Ejecting disks, 73, 
Put Away, 27 
Removing fi les, 27 
With Option key, 28 

Colophon 
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Turning it on, 9 
Typing, 39-48 
Undo, 46 

Keyboard shortcut, 24 
Unlock, 7, 30, 92 
Variations of a doc't, 65 
Venice, 49, 50, 53-5 
Viewing the window, 21-2 
Virus, 90, 95 
vVDEF virus, 90 
White scroll bar, 19, 20 
Windows, 19-24 

Active window, 23 
Clean up, 23 
Close all, 23 
Close box, 21 
Grey scroll bar, 20 
Icon, 19, 25 
Organizing, 3 1, 150 
Print active window, 24 
Print all windows, 24 
Scroll arrows, 20 
Scroll box, 21 
Title bar, 19 
Viewing, 22 
White scro ll bar, 12, 13 
Zoom box, 19, 20 

Word wrap, 40 
Zapf Chancery, 50, 57 
Zapf Dingbats, 50, 57, 103 
Zoom box, 19, 20 

This book was produced on a Mac SE with a 20 meg 
internal hard disk, Claris Mac Write II for word processing, 
Silicon Beach's SuperPaint for cleaning up the screen 
dumps, Aldus Pagemaker 3.02 fo r the page design and 
layout (tha nk goodness for style sheets!), an Apple Laser­
Writer for proofing, and a Linotronic fo r final output to 
go to press. 

The fon ts are the 1TC New Baskerville and the Futura 
fa milies, both from Adobe Systems Incorporated. 



Text Zapf Shift Option Shift & Za~f Dingbats Option 
~ ;;...- ® , In lhe chart to the left, find the Zapf Dingbat 

2 ~ + • -~ you wish to type. Hold down the Shift, the 

3 ./ ~ • _. Option , or the Shift-and-Option keys while . 
4 v ~ • -· pressing the text character. The dingbat in 

• 
5 X '8' ® --+ 

the Zapf column needs no exu·a keys. 

6 • ~ • -
7 X ({) ~ .. 
8 )( ... • !T n (outlined) 0 Sh- ] " 
9 + + (i) - Sh- - " (outlined) 0 
0 <{? r;:: 8 );>- Sh- [ i 

{b " fj (l) t (outlined) v Sh- \ ' 
= t .... ® ® s (outlined) 6 
q 0 * 0 0 u (outlined) 0 
w • * @ )> 

Opt-6 (outlined) c::? 
e * .;. ~ >-
r 0 * + .. 

'Y * 
,. 

Opt-Sh-/ CD Q) 
y I • ® • Opr-u-spac<.: 

u • * <D • Opr-1 @ Opt-= @ 

* i::l ltl c:> 
Opr-1 ® Opt-Sh-' ® 

0 0 * ® @ 

p 0 -c( 0 ~ Opt-v @ Opt-Sh-o @ 

[ ::: i 0 @ @ ® Opt-f Opr-5 
l * " -+ --? 

a 0 ¢ I ) Opt-x @ Opt-Sh-= ® 
s ... * ~-- <> (J) ® 
d * + 0 Q 

Opt-j Opt-, 

f ... ,:,: .. + ® 0 Opt-\ ® Opt-. ® 
g ;tE <0- • 0 

Opt-Sh-\ ® Opt-y @ 
h * * -) 0 

j ... 
';.: ; 0 (f) 0 Opt-; (@ Opt-m ® 

k * * •• 
• * Q) 0 

+ + ®l ~ Opt-d 0 Opt-Spcbar 0 
@ }< g) @ 

z I • G) •• Opt-w @ Opt-· then Sh-a @ 

X * ® " Opr-Sh-p @ Opt-n then Sh-a €) 
c * 

. I ( 

v ·:· * @) t Opr-p 0 Opt-n then Sh-o 0 
b 0 + 0 Opt-b @ Opt-Sh-q 0 
n • * " 

.,. 
m 0 * @ .... Opt-q 0 Opt-q 0 

~ ~ (f) Jt+ 
Opt-0 8 Opt-- fj 

~ 'i? @ .. 
I @ t ' . (j) Opt-z G) Opt-Sh-- (l) 

rS'J " rS'J - @ Opt-[ 0 Opt-' 
spacebar 0 0 
\ * ' ® ® Opt-o @ Opt-Sh-[ (ID 



A HANDY CHART 

Here is " Option- [ Opening double quote 

a handy chart " Option -Shift- [ Closing double quote 
for finding 

' Option-] Opening single quote 
some of the 

special characters . 
, Option- Shift-] Closing single quote; 

available that . Apostrophe 

will make your . Hyphen Hyphen 
work look more Option - Hyphen En dash 

professional 
Option- Shift- Hyphen Em dash 

Option-; Ellipsis (this character 
cannot be separated at the 
end of a line as the three 
periods can) 

• Option -8 Bullet 

0 0 (in font Zapf Dingbats) 

• n (in font Zapf Dingbats) 

D n (outlined) (in font Zapf Dingbats) 

© Option -g Copyright symbol 
TM Option- 2 Trademark symbol 

® Option- r Registration symbol 
0 Option -Shift- 8 Degree symbol: 105° F 

¢ Option-$ Cents symbol 

I Option -Shift - ! Fraction bar (it doesn 't 
descend below the base-
line as the slash does) 

fi Option -Shift- 5 Ligature for f and i 

fl Option - Shift - 6 Ligature for f and I 

£ Option- 3 English pound sign 

( Option -Shift-? Spanish symbol 

~ Option- c Cedilla, lowercase 

c Option- Shift- c Cedilla, capital 

3€ Control -Q (only in tl1e Chicago font; 
the Control key is not on 
a Mac Plus keyboard) 

Accent Marks Option - e 

Refer to page 48 to learn · Option--
how to type these in; · Option- u 
this page is merely a · 

Option- n quick reference · 
1\ Option- i 
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T H E L I T T L E 

M B 0 0 K 

A N INFORMAL G U I D E 

Here is your handy reference to the Macintosh, loaded with 

hundreds of useful tips, shortcuts, and troubleshooting techniques: 

• Orientation: The "unwriHen rules" that govern the Mac's 
system of menus, icons, and windows. 

• Time Savers: Dozens of mouse and keyboard shortcuts. 
• Working Smart: How to organize your folders, files, fonts, 

programs, and desk accessories. 
• Looking Good in Print: Essential tips on typography and 

font selection. 
• Handy Tools: How to use the Font/DA Mover and desk 

accessories like the Control Panel to customize your system. 
• Help! What to do when you don't know w hat to do. 

"I recommend The Little Mac Book to everyone walking in the 
door for training-read this book firs t!" 

-Harry Critchfield, Training Coordinator 
SMUG (Berkeley Macintosh User Gtoup) 

"The Little Mac Book is accessible, interesting, to the point, 
organized the way my mind works, simple enough for me to 
grasp-and clear enough to understand. This book thinks like 
the Moe does and like I do." 

-Jan V. White, designer/author 
Graphic Design for the Electronic Age 

I SB N 0-938151 - 21-S 
Peechpit Press 
1085 Keith Ave. 
Berkeley, CA 94708 
800 283·94l4 51295 
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$ 12.95 415 527·8555 
fax: 415 521-9775 
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